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Welcome to the SureColor P600 User's Guide.
For a printable PDF copy of this guide, click here.
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Product Basics

See these sections to learn about the basic features of your product.

Using the Control Panel

Product Parts Locations

The Power Off and Sleep Timers

Epson Connect Solutions for Smartphones, Tablets, and More
Using AirPrint

Using Google Cloud Print

Using the Control Panel
See these sections to learn about the control panel and select control panel settings.

Control Panel Buttons and Lights
The LCD Screen

Adjusting Control Panel Position
Changing LCD Screen Language
Adjusting the Screen Brightness

Parent topic: Product Basics

Control Panel Buttons and Lights
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The O power light

The M home button

The O power button

The 3 back button

The LCD screen

The up and down arrow buttons

D O~ WN P

Parent topic: Using the Control Panel

The LCD Screen

1 LLaL>,

Load Guide

Status icons

Load Guide displays when no paper is loaded; Media Setup displays when paper is loaded
Displays the level of ink remaining

Changes the black ink type

Displays the network status

Opens the setup menu

N oo o~ WDN P

Ejects paper
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Status Icons
Parent topic: Using the Control Panel
Status Icons
Status icons may be displayed on the LCD screen depending on the product's status.

Description

Photo Black ink is selected.

(@]
(@]
=}
(7]

Matte Black ink is selected.

@
=

Ink is low.

Displays the status of the Ethernet connection.

Wired or wireless network connection has been established.

Wi-Fi connection has been established. The number of lit bars indicates the
connection's signal strength.

Ad hoc connection has been established.

Wi-Fi Direct mode connection has been established.

Simple AP mode connection has been established.

D L e
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Description

Auto Sheet Feeder setting is selected (displays in Load Guide).

Fine Art Media setting is selected (displays in Load Guide).

Poster Board setting is selected (displays in Load Guide).

CD/DVD setting is selected (displays in Load Guide).

Indicates that Roll Paper is selected in Load Guide.

Thick Paper setting is set to On.

HAIFIEO00¢

Parent topic: The LCD Screen

Adjusting Control Panel Position

You can adjust the position of the control panel to make it easier to access. Raise or lower it to the
desired angle as shown.
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Parent topic: Using the Control Panel

Changing LCD Screen Language

You can change the language used on the LCD screen.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the M home button, if necessary.

2. Press the il setup button.
You see a screen like this:

I¥ Setup
Maintenance

System Administration

Network Status
Print Status Sheet

Select System Administration. Enter the administrator password, if necessary.
Select Common Settings.
Press the down arrow button and select Language.

S

Select a language.
Parent topic: Using the Control Panel

Adjusting the Screen Brightness
You can adjust the brightness of the LCD screen.
1. Press the ™ home button, if necessary.
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2. Press the il setup button.
You see a screen like this:

Iy Setup

Maintenance

System Adminmistration

Network Status

Print Status Sheet

Select System Administration. Enter the administrator password, if necessary.
Select Common Settings.

Select LCD Brightness.

Tap the left or right arrows to adjust the screen brightness.

Select OK to exit.

Parent topic: Using the Control Panel

N o o bk~ ow

Product Parts Locations

See these sections to identify the parts on your product.

Product Parts - Front
Product Parts - Inside
Product Parts - Back

Parent topic: Product Basics
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Product Parts - Front

Printer cover

Front cover

Output tray

Front manual feed tray
Control panel

Sheet feeder

Edge guide

0 N o ok~ WN P

Paper support and extensions
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9 CD tray
10 Roll paper holders

Parent topic: Product Parts Locations

Product Parts - Inside

1 Ink cartridge cover
2  Inkpad
3 Print head

Parent topic: Product Parts Locations
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Product Parts - Back

AC inlet

1

2 Vent

3  USB port

4 LAN port

5 Roll paper feed slot

6  Rear paper support and extension

Parent topic: Product Parts Locations

The Power Off and Sleep Timers

The product enters sleep mode or turns off automatically if it is not used for a period of time. You can
adjust the time period before power management, but increasing the time reduces the product's energy
efficiency.
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Changing the Power Off Timer Setting from the Control Panel
Changing the Sleep Timer Setting from the Control Panel
Changing the Power Off Timer Setting - Windows

Changing the Power Off Timer Setting - OS X

Parent topic: Product Basics

Changing the Power Off Timer Setting from the Control Panel

You can use the product's control panel to change the time period before the printer turns off
automatically.

1. Press the M home button, if necessary.

2. Press the il setup button.
You see a screen like this:

Iy Setup

Maintenance

System Adminmistration

Network Status
Print Status Sheet

Select System Administration.
Select Common Settings.
Select Power Off Timer.

L

Select the length of time after which you want the product to automatically turn off when itis not in
use.

Parent topic: The Power Off and Sleep Timers
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Changing the Sleep Timer Setting from the Control Panel
You can use the product's control panel to change the time period before the product enters sleep mode.
1. Press the M home button, if necessary.

2. Press the il setup button.
You see a screen like this:

I¥ Setup
Maintenance

System Administration

Network Status

Print Status Sheet

Select System Administration.

Select Common Settings.

Select Sleep Timer.

Select + or — to select the time period you want before the product goes to sleep. Then select OK.

o gk~ w

Parent topic: The Power Off and Sleep Timers

Changing the Power Off Timer Setting - Windows
You can use the printer software to change the time period before the printer turns off automatically.

1. Access the Windows Desktop, right-click the product icon in the Windows taskbar, and select
Printer Settings.

2. Click the Utility tab and select Printer and Option Information.
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3.

4. Click Send.
5. When you see the time you selected listed as the Current Printer Setting, click OK.

You see this window:

off

Printer and Option Information

Power Off Timer
Current Printer Setting : Off

W Send

In the drop-down menu, select the length of time after which you want the product to automatically

turn off when it is not in use.

Parent topic: The Power Off and Sleep Timers

Changing the Power Off Timer Setting - OS X

You can use the printer software to change the time period before the printer turns off automatically.

In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or

1.
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select

Open Printer Utility.
Select Printer Settings.
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You see this window:

ann Epson Printer Utilivy 4

Buy Epson Ink

EPSON epson

Werskan 9,33 (9.3

FReady
@ Connected | Updare |
EPQUN Status Mozzle Check Head Cleaning Print Head
Alignanent
Printer Seitings

3. Select the length of time after which you want the product to automatically turn off when itis not in
use as the Power Off Timer setting.

4. Click Apply.
5. Close the Printer Settings window.
Parent topic: The Power Off and Sleep Timers

Epson Connect Solutions for Smartphones, Tablets, and More

You can print documents, photos, and web pages from your home or office. You can use your
smartphone, tablet, or computer. Epson offers these solutions to print from anywhere: Epson iPrint
Mobile App and Epson Remote Print.

Using the Epson iPrint Mobile App
Using Epson Remote Print

Parent topic: Product Basics
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Using the Epson iPrint Mobile App

Use this free Apple and Android app to print to nearby Epson networked products. The Epson iPrint
Mobile App lets you print PDFs, Microsoft Office documents, photos, and web pages over a wireless

network.

1. Setup your product on a network as described in this manual. See the link below.

2. Visit epson.com/connect to learn more about Epson iPrint and check the compatibility of your mobile
device.

3. Download Epson iPrint from the Apple App Store or Google Play.

4. Connect your mobile device to the same wireless network that your product is using.

5. Print from your mobile device to your Epson product.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking

Using Epson Remote Print

With Epson Remote Print software on your Windows computer or laptop, you can print to an Epson
Email-enabled product anywhere in the world.

M wnDn

Set up your product for network printing as described in this manual. See the link below.
Visit epson.com/connect to learn more about Remote Print and how to download the software.
Download and install the Remote Print software.

Obtain the email address and optional access key of the Epson product you want to use for printing,
and enter this address during Remote Print setup.

Select the print command in your application and choose the Remote Print driver for your Epson
product.

Parent topic: Epson Connect Solutions for Smartphones, Tablets, and More

Related topics
Wi-Fi or Wired Networking
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Using AirPrint

AirPrint allows you to wirelessly print to your AirPrint-enabled product from your iOS device running the
latest version of iOS, and from your Mac running OS X 10.7 or later.

Note: If you disabled paper configuration messages on your product control panel, you cannot use
AirPrint. See the link below to enable the messages, if necessary.

1. Setup your product for wireless printing as described in this manual. See the link below.
2. Connect your Apple device to the same wireless network that your product is using.
3. Print from your device to your product.

Note: For details, see the AirPrint page on the Apple website.

Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Using Google Cloud Print

With a Google Account, you can print from your Apple or Android device to your Epson product. You can
also print from Chromebooks and the Google Chrome browser without drivers or cables.

Set up your Epson product for network printing as described in this manual. See the link below.

Note: Make sure your Epson printer and computer are connected to the same network before starting
the Google Cloud Print setup.

Connect your device to the same network that your Epson product is using.
Print a network status sheet.
Locate your product's IP address on the network status sheet.

P w N PR

Enter the IP address into the address bar of a web browser.
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5. Select the Google Cloud Print Services option.

Note: If you don't see the Google Cloud Print Services option, turn your product off and back on. If
the option still doesn't appear, select the Firmware Update option and follow the on-screen
instructions to update your product.

6. Click Register.

7. Select the checkbox to agree to the Usage Advisory and click Next.
Click OK to launch the sign-in page.
A separate browser window opens.

9. Enter your Google Account username and password and click Sign in, or, if you don't have an
account, click Sign up for a new Google Account and follow the on-screen instructions.

10. Click Finish printer registration to complete setup and print a test page.

Your product is how linked to your Google Account and can be accessed from any Chromebook,
computer, Apple or Android device with Internet access. Visit Epson Support for more information on
using Google Cloud Print, or the Google Cloud Print website for a list of supported apps.

Setting Up Google Cloud Print on a Chromebook
Parent topic: Product Basics

Related topics
Wi-Fi or Wired Networking

Setting Up Google Cloud Print on a Chromebook
With a Google Account, you can print from a Chromebook without drivers or cables.
Set up your Epson product for network printing as described in this manual. See the link below.

Note: Make sure your Epson product is connected to your wireless network before starting the Google
Cloud Print setup.

1. Turn on your Chromebook and connect it to the same wireless network as your product.

Note: See your Chromebook's documentation for details on connecting to a network.
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2. Do one of the following:

« Click Add to Cloud Print in the notification that appears in the corner of your Chromebook
screen.

Note: If you do not see a notification, check to see if a number appears in the status area at the
lower-right corner of the screen. Click this number to open the notifications menu, then click Add
to Cloud Print.

» Open a web browser and enter chrome://devices in the address bar. Skip to step 4.
3. Click Add Device.
Click the Register button that appears next to your product.

5. Click Register on the confirmation screen. Your product's LCD screen displays a confirmation
message.

6. Select OK or press the OK button on your product to confirm the Google Cloud Print connection and
print a test page.

Your product is how linked to your Google Account and can be accessed from any Chromebook,
iPhone, or Android phone with Internet access. For more information on using Google Cloud Print,
visit Epson Support.

Parent topic: Using Google Cloud Print
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Wi-Fi or Wired Networking

See these sections to use your product on a Wi-Fi or wired network.
Wi-Fi Infrastructure Mode Setup

Wi-Fi Direct Mode Setup

Wi-Fi Protected Setup (WPS)

Printing a Network Status Sheet

Changing or Updating Network Connections

Wi-Fi Infrastructure Mode Setup

You can set up your product to communicate with your computer using a wireless router or access point.
The wireless router or access point can be connected to your computer over a wireless or wired network.

1  Epson product
2 Wireless router or access point
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Computer with a wireless interface
Computer
Internet

o o b~ W

Ethernet cable (used only for wired connection to the wireless router or access point)

Selecting Wireless Network Settings from the Control Panel
Parent topic: Wi-Fi or Wired Networking

Selecting Wireless Network Settings from the Control Panel
You can select or change wireless network settings using your product control panel.
To install your product on a wireless network, follow the instructions on the Start Here sheet and install
the necessary software. The installer program guides you through network setup.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not
responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your network data and settings.
1. Press the M home button, if necessary.
2. Pressthe network status icon.
3. Select Wi-Fi Setup.

You see a screen like this:

m

| Wi-Fi Setue Wizard

i |
| Push Bution Setup (WES)

|

| PN Coxde Setup (RPS) L'll
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Select Wi-Fi Setup Wizard.

Note: If you need to disable the wireless network to set up your product on an Ethernet network,
press the down arrow button, select Disable Wi-Fi, and press the OK button. Then follow the
instructions on changing to a wired network connection in this guide.

Select the name of your wireless network or enter the name manually.

Note: To enter the wireless network name manually, select Other Networks and select the
Network (SSID) field. Use the displayed keypad to enter your network name.

Select the Password field and enter your wireless password using the displayed keypad.

™~
-
™
-
=
=
=l

Note: The network name and password are case sensitive. Be sure to correctly enter uppercase and
lowercase letters, and numeric or special characters.

¢ Press El or El to move the cursor.

* Press EI to change the case of letters.

* Press E to delete the previous character.
* Press to enter numbers and symbols.
* Press El to enter a space.

Press when you finish entering your password and select Proceed.
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8. Confirm the displayed network settings and select OK to save them.
Note: If you need to change a setting, press the 3 back button.

9. If you want to print a network setup report, select Print. (Otherwise, select Done.)
10. Press the M home button to exit.

Your product should now be connected to the network.

Note: If the WiFi connection symbol does not appear lit on the LCD screen, you may have selected
the wrong network name or entered the password incorrectly. Repeat these steps to try again.

Parent topic: Wi-Fi Infrastructure Mode Setup

Wi-Fi Direct Mode Setup

You can set up your product to communicate directly with your computer or another device without
requiring a wireless router or access point.

1  Epson product
2  Computer with a wireless interface
3  Other wireless device

You can select one of these modes to communicate with your computer or device:
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Access point mode
The product itself acts as the network access point for up to 4 devices. When operating in this mode,
your product displays an AP connection symbol on the LCD screen.

Peer-to-peer mode
The product communicates one-to-one with another Wi-Fi Direct capable device. When operating in
this mode, your product displays a Direct or D connection symbol on the LCD screen.

To disconnect a peer-to-peer mode connection, release the connection to your product from your
computer or other device.

To enable peer-to-peer mode, you must select it from the Web Config Utility, under Advanced
Settings > Services > Wi-Fi Direct.

Enabling Wi-Fi Direct Mode
Parent topic: Wi-Fi or Wired Networking

Enabling Wi-Fi Direct Mode
You can enable Wi-Fi Direct mode to allow direct communication between your product and a computer
or other devices without a wireless router or access point.

Note: You may need to enable the Wi-Fi Direct setting in the Advanced Settings menu before you can
enable Wi-Fi Direct mode.
1. Press the M home button, if necessary.

2. Pressthe network status icon.
3. Select Wi-Fi Setup.
You see a screen like this:

Quiser ———_m

&
Wi-Fi Selup Wizard I
| Push Button Setup (WE'S)
I_
|
| PiH Code Setup (%PS) L:'l
I T
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Scroll down and select Wi-Fi Direct Setup.
Select Connection Setup.
Select Change Password and select Yes.

Note: If you have already connected devices or computers to your product via Wi-Fi Direct, they are
disconnected when you change the password.

Enter your new Wi-Fi Direct password.

Note: Your password must be at least 8 and no more than 22 characters long.

* Press E or E to move the cursor.

* Press ﬂ to change the case of letters.

* Press E to delete the previous character.

e Press to enter numbers and symbols.

* Press E| to enter a space.

Press when you finish entering your password.
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You see a screen like this:

|I::I Wi=Fi Carect Sefup

Connecting via Wi-Fi Direct

9. Scroll down to view the SSID (Wi-Fi network name) and password.

10. Use your computer or wireless device to select the Wi-Fi network name (SSID) displayed on the
LCD screen, then enter the password shown.

11. Press the M home button to exit.
You see either an AP or Direct connection symbol on the LCD screen and should be able to print
directly to your product from your computer or device.

Note: If the AP or Direct connection symbol is not displayed on the LCD screen, Wi-Fi Direct mode
is not enabled. Repeat these steps to try again.

Parent topic: Wi-Fi Direct Mode Setup

Wi-Fi Protected Setup (WPS)

If your network uses a WPS-enabled wireless router or access point, you can quickly connect your
product to the network using Wi-Fi Protected Setup (WPS).

Note: To check if your router is WPS-enabled, look for a button labeled WPS on your router or access
point. If there is no hardware button, there may be a virtual WPS button in the software for the device.
Check your network product documentation for details.

Using WPS to Connect to a Network
Parent topic: Wi-Fi or Wired Networking
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Using WPS to Connect to a Network

If you have a WPS-enabled wireless router or access point, you can use Wi-Fi Protected Setup (WPS) to
connect your product to the network.

1. Press the M home button, if necessary.
2. Pressthe network status icon.
3. Select Wi-Fi Setup.

You see a screen like this:

" A
Wi-Fi Setup Wizard -

| I

I Push Button Setup (AFS)

T —

| FiH Code Setup {AFS) LJ
I Y|

4. Select Push Button Setup (WPS) and select Proceed.
Follow the instructions on the LCD screen to complete WPS setup.
Press the M home button to exit.
Your product should now be connected to the network.

Parent topic: Wi-Fi Protected Setup (WPS)

Printing a Network Status Sheet

You can print a network status sheet to help you determine the causes of any problems you may have
using your product on a network.

1. Press the M home button, if necessary.
2. Press the Il setup button.

3. Select Network Status.

4. Select Wi-Fi/Network Status.
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You see a screen like this:

&1 Wi-FiHetrork Status

el
ain [P fadilress

Print

Note: If you are connected to a wireless network, the signal strength is also displayed.

5. Select Print.

6. Select Print again to print the network status sheet.

Examine the settings shown on the network status sheet to diagnose any problems you have.
Parent topic: Wi-Fi or Wired Networking

Changing or Updating Network Connections
See these sections to change or update how your product connects to a network.

Accessing the Web Config Utility

Changing a USB Connection to a Wi-Fi Connection
Changing a Wi-Fi Connection to a Wired Network Connection
Connecting to a New Wi-Fi Router

Disabling Wi-Fi Features

Parent topic: Wi-Fi or Wired Networking

Accessing the Web Config Utility

You can select your product's network settings and confirm its operating status using a web browser.
You do this by accessing your product's built-in Web Config utility from a computer or other device that is
connected to the same network as your product.

1. Print a network status sheet.
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2. Locate the IP Address for your product that is listed on the network status sheet.

3. On acomputer or other device connected to the same network as your product, open a web
browser.

4. Enter your product's IP address into the address bar.
You see the available Web Config utility options.
Parent topic: Changing or Updating Network Connections

Related tasks
Printing a Network Status Sheet

Changing a USB Connection to a Wi-Fi Connection

If you have already connected your product to your computer using a USB connection, you can change
to a Wi-Fi connection or add a Wi-Fi connection to print wirelessly.

1. Do one of the following:

 If you want to use only a Wi-Fi connection, disconnect the USB cable from your product. With
Windows, also uninstall your product software.

* If you want to add a Wi-Fi connection in addition to a USB connection, leave the USB cable
connected to your product.

2. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections

Changing a Wi-Fi Connection to a Wired Network Connection

If you have already connected your product to your computer wirelessly, you can change to a wired
network connection if necessary.

Disable your product's Wi-Fi features.

Connect one end of an Ethernet network cable to the product's LAN port.

Connect the other end to any available LAN port on your router or access point.
Uninstall your product software.

Download and install your product software from the Epson website.

Follow the on-screen instructions to install the software.

When you see the Select Your Connection screen, select Wired network connection.

No g bk wbd e
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8. Ifyou see a Select Setup Option screen, select Setup printer for the first time.
9. Continue following the rest of the on-screen instructions.
Parent topic: Changing or Updating Network Connections

Related tasks
Disabling Wi-Fi Features

Connecting to a New Wi-Fi Router

If you change the wireless router you have been using on your network, you need to update your
product's Wi-Fi connection to the new router.

Note: If you switch to a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5
GHz) mode. See your router documentation for instructions.

1. Do one of the following:
« Windows: Uninstall your product software.

* OS X: Go to the next step.

2. Download and install your product software from the Epson website using the instructions on the
Start Here sheet.

Parent topic: Changing or Updating Network Connections

Related tasks
Uninstalling Printing Software - Windows

Disabling Wi-Fi Features

You may need to disable your product's Wi-Fi features if you change your network connection type or
need to solve a problem with your network connection.

Note: Before disabling Wi-Fi features, make a note of your product's SSID (network name) and
password, and any network settings selected for the Epson Connect services you may use.

1. Press the M home button, if necessary.

2. Pressthe network status icon.
3. Select Wi-Fi Setup.
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You see this screen:

& WeFi Setup

[
Wi-Fi Selup Wizard I .

Push Button Setup (NPS) | I
PIH Coske Setup (HPS) |_t

4. Scroll down and select Disable Wi-Fi.
5. Select Yes to disable Wi-Fi.

Parent topic: Changing or Updating Network Connections
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Loading Media

Before you print, load media for the type of printing you will do.

Note: Loading media automatically displays the setup screen for media type and size. To turn this

display off, press the 1Y) setup button, select System Administration > Printer Settings > Paper
Source Settings > Paper Setup Display > Off.

Loading Paper in the Sheet Feeder

Loading Fine Art Media

Loading Thick Media

Loading Roll Paper

Cut Sheet Media Loading Capacity

Available Epson Papers

Borderless Paper Type Compatibility

Paper or Media Type Settings - Product Software

Selecting the Paper Settings for Each Source - Control Panel
Selecting the Default Paper Setup Display and Error Notice Settings

Loading Paper in the Sheet Feeder
You can print on a variety of paper types and sizes from paper loaded in the sheet feeder.
1. Turnon your product.
2. Open the paper support and pull up the extensions.
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3. Open the front cover.
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5. Insert paper, glossy or printable side up, short edge first, against the right edge and behind the tab.

7. When prompted by the product's LCD screen, select the size and type of the paper you loaded and
select OK.

Always follow these paper loading guidelines:
* Load only the recommended number of sheets.

» Load paper short edge first, no matter which way your document faces.
* Load the printable side faceup.
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« Load letterhead or pre-printed paper top edge first.

» Do not load paper above the arrow mark inside the edge guide.

» Check the paper package for any additional loading instructions.
Parent topic: Loading Media

Related references
Cut Sheet Media Loading Capacity

Related tasks

Loading Fine Art Media

Loading Thick Media

Selecting the Paper Settings for Each Source - Control Panel
Selecting the Default Paper Setup Display and Error Notice Settings

Loading Fine Art Media

Use the front manual feed tray and the rear paper support to load fine art media.
Note: You can load fine art media with a thickness of 0.012 to 0.028 inch (0.3 to 0.7 mm).

Turn on your product.
Remove any paper from the sheet feeder and close the paper support.
Remove any roll paper and the roll paper holders.

P w PR

Open the rear paper support.
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5. Pull out the rear paper support extensions.

45



8. Insert a single sheet of fine art paper into the manual feed tray. Insert it short edge first with the
printable side up.

side.

10. Select Load on the LCD screen. The paper loads into your product.
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11. When you see a message telling you to extend the output tray, pull out and extend the tray fully.

12. When prompted by the product's LCD screen, select the size and type of the paper you loaded and
select OK.

13. Push in the manual feed tray until it latches.
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Note: To eject paper, select Eject on the LCD screen and select Yes to confirm.

Always follow these paper loading guidelines:

* Load only one sheet at a time.

» Load fine art media short edge first, no matter which way your document faces.
» Load the printable side faceup.

» Check the paper package for any additional loading instructions.

Parent topic: Loading Media

Related references
Cut Sheet Media Loading Capacity

Related tasks

Loading Paper in the Sheet Feeder

Loading Thick Media

Selecting the Paper Settings for Each Source - Control Panel
Selecting the Default Paper Setup Display and Error Notice Settings

Loading Thick Media

Use the front manual feed tray to load media that is 0.028 to 0.051 inch (0.7 to 1.3 mm) thick in this size:
13 x 19 inches (330 x 483 mm).

Note: Be sure to leave at least 13 inches (32 cm) of space behind your product for the media to feed
through.

1. Turnon your product.
2. Remove any paper from the sheet feeder and close the paper support.
3. Remove any roll paper and the roll paper holders.
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4. Close the rear paper support.
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7. Insert a single sheet of thick media into the manual feed tray. Insert it short edge first with the
printable side up.

Note: Never try to load media from the rear, or you could damage your product.

8. [Feed the paper up to the line near the end of the tray. Make sure the paper is flush against the right
side.

9. Select Poster Board - Load on the LCD screen. The paper loads into your product.
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10. When you see a message on the screen, push in the manual feed tray until it latches.

11. Pull out and extend the output tray fully.

Note: To eject paper, select Eject on the LCD screen and follow the displayed instructions. Do not
extend the manual feed tray during printing, or you may damage your product.
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Parent topic: Loading Media

Related references
Cut Sheet Media Loading Capacity

Related tasks

Loading Paper in the Sheet Feeder

Loading Fine Art Media

Selecting the Paper Settings for Each Source - Control Panel
Selecting the Default Paper Setup Display and Error Notice Settings

Loading Roll Paper

You can load 13-inch (330 mm) wide roll paper for printing large or panoramic images, or multiple
photos, with or without borders.

Note: It's a good idea to check the ink status and replace cartridges, if necessary, before printing a large
print job. If you need to replace a cartridge during printing, you can continue to print but you might notice
a color difference in your printout depending on drying conditions.

1. Turn on your product.
2. Remove any paper from the sheet feeder and close the paper support.
3. Open the front cover.
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4. Pull out and extend the output tray fully.

5. Remove any tape and protective paper from the end of the roll. Make sure the paper is cut straight
across to avoid paper feeding problems.

Note: Avoid touching the surface of your paper. With canvas media that you have previously loaded,
cut the edge straight each time you reload it for best results.

6. Place the roll paper holders on each end of the paper roll as shown. The holders are labeled L and R
(for left and right), as viewed from the front of the printer.
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7. Open the rear paper support but do not extend it.

8. Attach the roll paper holders as shown. Hook the holders onto the attachment points marked with
orange labels.

Note: Make sure the roll paper holders are firmly secured to your product.
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9. Feed the paper into your product until it meets resistance. In a few seconds, the paper loads
automatically.

Note: When loading canvas media, leave slack in the roll as it feeds and prints for the best results.

10. When prompted by the product's LCD screen, select the size and type of the paper you loaded and
select OK.

Cutting and Removing Roll Paper
Parent topic: Loading Media

Related references
Borderless Paper Type Compatibility

Related tasks
Selecting the Paper Settings for Each Source - Control Panel

Cutting and Removing Roll Paper
After printing on roll paper, use scissors as described here to cut the roll paper from your printout.
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1. When printing is finished, you see this screen:

B Information

Printing complete.
Cut off printed page?

No Cut Cut

2. Select Cut to print a cut line and feed the paper.
Note: If you select No Cut, you return to the main screen.

3. Use scissors to cut the paper along the cut line.
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4. Follow the instructions on the screen to unload the roll paper. Turn the knobs on the roll paper
holders backward as the paper unloads, then remove the paper and holders from your product.

Note: You can also unload roll paper by selecting Cut/Eject > Eject on the LCD screen.
Parent topic: Loading Roll Paper

Cut Sheet Media Loading Capacity

You can load cut sheet media in the paper types and quantities listed here into your product.

Sheet Feeder

Paper type Loading capacity
Plain paper 120 sheets
Epson Presentation Paper Matte 100 sheets Letter (8.5 x 11 inches

[216 x 279 mm])

50 sheets B4 (13.9 x 9.84 inches

[353 x 250 mmy]), B5 (7.2 x 10.1 inches
[182 x 257 mm]), 13 x 19 inches

(330 x 483 mm)

Epson Bright White Paper 80 sheets

Epson Photo Paper Glossy 30 sheets
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Paper type

Loading capacity

Epson Premium Photo Paper Glossy
Epson Ultra Premium Photo Paper Glossy

30 sheets 4 x 6 inches (102 x 152 mm), 8 x 10
inches (203 x 254 mm), Letter (8.5 x 11 inches
[216 x 279 mm]), 11 x 14 inches

(279 x 356 mm)

20 sheets 5 x 7 inches (127 x 178 mm)

10 sheets A3 (11.7 x 16.5 inches

[297 x 420 mm]), B4 (13.9 x 9.84 inches
[353 x 250 mm]), B5 (7.2 x 10.1 inches
[182 x 257 mm]), 13 x 19 inches

(330 x 483 mm)

Epson Ultra Premium Photo Paper Luster
Epson Ultra Premium Presentation Paper Matte

30 sheets Letter (8.5 x 11 inches
[216 x 279 mm])

10 sheets A3 (11.7 x 16.5 inches
[297 x 420 mm]), 13 x 19 inches
(330 x 483 mm)

Epson Metallic Photo Paper Glossy
Epson Metallic Photo Paper Luster

30 sheets Letter (8.5 x 11 inches
[216 x 279 mm])

10 sheets 13 x 19 inches (330 x 483 mm)

Epson Premium Photo Paper Semi-gloss

30 sheets 4 x 6 inches (102 x 152 mm), Letter
(8.5 x 11 inches [216 x 279 mm])

10 sheets 13 x 19 inches (330 x 483 mm)

Epson Premium Presentation Paper Matte

sided

Epson Premium Presentation Paper Matte Double-

30 sheets 8 x 10 inches (203 x 254 mm),
Letter (8.5 x 11 inches [216 x 279 mm)])

10 sheets 11 x 14 inches (279 x 356 mm), A3
(11.7 x 16.5 inches [297 x 420 mm]), 13 x 19
inches (330 x 483 mm)

Epson Photo Quality Self-adhesive Sheets

1 sheet

Manual Feed Tray

You can load one sheet of posterboard or other thick media 0.028 to 0.051 inch (0.7 to 1.3 mm) thick in
this size in the front manual feed tray: 13 x 19 inches (330 x 483 mm).You can also load one sheet of the

following types of fine art paper:
» Epson Velvet Fine Art Paper
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» Epson UltraSmooth Fine Art Paper

» Epson Watercolor Paper Radiant White

» Epson Exhibition Fiber Paper

» Epson Exhibition Watercolor Paper Textured
» Epson Hot Press Bright

» Epson Hot Press Natural

» Epson Cold Press Bright

* Epson Cold Press Natural

» Epson Exhibition Canvas Matte

Parent topic: Loading Media

Available Epson Papers

You can purchase genuine Epson ink and paper at Epson Supplies Central at epson.com/ink3 (U.S.
sales) or epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller.
To find the nearest one, call 800-GO-EPSON (800-463-7766).

Note: Paper/media availability varies by country.

Paper Type Size Part number Sheet count

Epson Bright White Paper Letter (8.5 x 11 inches S041586 500
[216 x 279 mm])

Epson High Quality Ink Jet Paper |Letter (8.5 % 11 inches S041111 100
[216 x 279 mm])

Epson Cold Press Bright Letter (8.5 x 11 inches S042307 25
[216 x 279 mm])
13 x 19 inches S042310 25
(330 x 483 mm)

Epson Cold Press Natural Letter (8.5 x 11 inches S042297 25
[216 x 279 mm])
13 x 19 inches S042300 25
(330 x 483 mm)
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Paper Type Size Part number Sheet count
Epson Velvet Fine Art Paper Letter (8.5 x 11 inches S041636 20
[216 x 279 mm])
13 x 19 inches S041637 20
(330 x 483 mm)
Epson Exhibition Fiber Paper Letter (8.5 x 11 inches S045033 25
[216 x 279 mm])
13 x 19 inches S045037 25
(330 x 483 mm)
Epson Hot Press Bright Letter (8.5 x 11 inches S042327 25
[216 x 279 mm])
13 x 19 inches S042330 25
(330 x 483 mm)
Epson Hot Press Natural Letter (8.5 x 11 inches S042317 25
[216 x 279 mm])
13 x 19 inches S042320 25
(330 x 483 mm)
Epson Exhibition Watercolor Paper | Letter (8.5 x 11 inches S045486 25
Textured [216 x 279 mm])
13 x 19 inches S045487 20
(330 x 483 mm)
Epson Brochure & Flyer Paper Letter (8.5 x 11 inches S042384 150
Matte Double-sided [216 x 279 mm])
Epson (Consumer) Sample Media | Various sizes SMP603 Various
Pack guantities
Epson Photo Quality Self-adhesive | A4 (8.3 x 11.7 inches S041106 10
Sheets [210 x 297 mm])
Photo Quality Ink Jet Cards A6 (4.1 x 5.8 inches S041054 50
[105 x 148 mm])
Epson Ultra Premium Photo Paper |Letter (8.5 x 11 inches S042175 20
Glossy [216 x 279 mm])
8 x 10 inches (203 x 254 mm) |S041946 20
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Paper Type Size Part number Sheet count
Epson Premium Luster Photo 8.3 inches (211 mm) x 32 feet | S041408 1roll
Paper (260) (9.8 m)
13 inches (330 mm) x 32 feet |S041409 1 roll
(9.8 m)
10 inches (254 mm) x 100 feet | S042077 1roll
(30.5m)
Epson Metallic Photo Paper Letter (8.5 x 11 inches S045589 25
Glossy [216 x 279 mm])
13 x 19 inches S045590 25
(330 x 483 mm)
Epson Metallic Photo Paper Luster | Letter (8.5 x 11 inches S045516 25
[216 x 279 mm])
13 x 19 inches S045517 25
(330 x 483 mm)
Epson Photo Paper Glossy Letter (8.5 x 11 inches S041649 50
[216 x 279 mm])
11 x 17 inches S041156 20
(279 x 432 mm)
13 x 19 inches S041143 20
(330 x 483 mm)
Letter (8.5 x 11 inches S041271 100

[216 x 279 mm])
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Paper Type Size Part number Sheet count
Epson Premium Photo Paper Letter (8.5 x 11 inches S041286 20
Glossy [216 x 279 mm])
A3 (11.7 x 16.5 inches S041288 20
[297 x 420 mm])
13 x 19 inches S041289 20
(330 x 483 mm)
Letter (8.5 x 11 inches S041667 50
[216 x 279 mm])
11 x 17 inches S041290 20
(279 x 432 mm)
4 x 6 inches (102 x 152 mm) | S041727 100
5x 7inches (127 x 178 mm) | S041464 20
8 x 10 inches (203 x 254 mm) |S041465 20
11 x 14 inches S041466 20
(279 x 356 mm)
Epson Premium Photo Paper 4 x 6 inches (102 x 152 mm) |S041982 40
Semi-gloss Letter (8.5 x 11 inches S041331 20
[216 x 279 mm])
13 x 19 inches S041327 20
(330 x 483 mm)
8 x 10 inches (203 x 254 mm) |S041467 50
Letter (8.5 x 11 inches S041257 50
[216 x 279 mm])
11 x 14 inches S041468 50
(279 x 356 mm)
A3 (11.7 x 16.5 inches S041260 50
[297 x 420 mm])
13 x 19 inches S041263 50

(330 x 483 mm)
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Paper Type Size Part number Sheet count
Epson Premium Presentation Letter (8.5 x 11 inches S041568 50
Paper Matte Double-sided [216 x 279 mm])
Epson Premium Presentation Letter (8.5 x 11 inches S041062 100
Paper Matte [216 x 279 mm])
Legal (8.5 x 14 inches S041067 100
[216 x 356 mm])
11 x 17 inches S041070 100
(279 x 432 mm)
13 x 19 inches S041069 100
(330 x 483 mm)
16.5 x 23.4 inches (420 x 594 [S041079 30
mm)
17 x 22 inches S041171 100
(432 x 559 mm)
Epson Proofing Paper White 13 x 19 inches S045115 100
Semimatte (330 x 483 mm)
13 inches (300 mm) x 100 feet | S042002 1roll
(30.5m)
Epson Standard Proofing Paper 13 inches (300 mm) x 100 feet | S041996 1roll
Publication (30.5m)
Epson Standard Proofing Paper 13 inches (300 mm) x 100 feet | S042144 1roll
Commercial (30.5m)
Epson Signature Worthy Sample | Letter (8.5 x 11 inches S045234 14
Pack [216 x 279 mm])
Epson Standard Proofing Paper 13 x 19 inches S045115 100

(240)

(330 x 483 mm)
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Paper Type Size Part number Sheet count
Epson Ultra Premium Photo Paper |Letter (8.5 x 11 inches S041405 50
Luster [216 x 279 mm])
A3 (11.7 x 16.5 inches S041406 50
[297 x 420 mm])
13 x 19 inches S041407 50
(330 x 483 mm)
13 x 19 inches S041604 100
(330 x 483 mm)
17 x 22 inches S042084 25
(432 x 559 mm)
13 inches S041409 1 roll
(330 mm) x 32.8 feet (10 m)
Epson Ultra Premium Presentation | Letter (8.5 x 11 inches S041341 50
Paper Matte [216 x 279 mm])
A3 (11.7 x 16.5 inches S041343 50
[297 x 420 mm])
13 x 19 inches S041339 50
(330 x 483 mm)
13 x 19 inches S041605 100
(330 x 483 mm)
17 x 22 inches S041908 100
(432 x 559 mm)
Epson UltraSmooth Fine Art Paper |13 x 19 inches S041896 25
(330 x 483 mm)
17 x 22 inches S041897 25
(432 x 559 mm)
Epson Watercolor Paper Radiant |13 x 19 inches S041351 20
White (330 x 483 mm)
Epson Exhibition Canvas Matte 13 inches (330 mm) x 20 feet | S045255 1roll

(6.1 m)
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Paper Type Size Part number Sheet count

Epson Exhibition Canvas Satin 13 inches (330 mm) x 20 feet |S045248 1roll
(6.1 m)

Epson Exhibition Canvas Gloss 13 inches (330 mm) x 20 feet |S045241 1roll
(6.1 m)

Epson Exhibition Canvas Natural |13 inches (330 mm) x 20 feet |S045241 1 roll

Matte (6.1 m)

Epson Exhibition Canvas Natural |13 inches (330 mm) x 20 feet |S045396 1roll

Satin (6.1 m)

Epson Exhibition Canvas Natural |13 inches (330 mm) x 20 feet |S045410 1roll

Gloss (6.1 m)

Parent topic: Loading Media

Borderless Paper Type Compatibility

You can print borderless photos on compatible paper types in compatible sizes.

Borderless Paper Types

» Epson Brochure & Flyer Paper Matte Double-sided
» Epson Ultra Premium Presentation Paper Matte

* Epson Premium Presentation Paper Matte

» Epson Premium Presentation Paper Matte Double-sided
» Epson Ultra Premium Photo Paper Glossy

» Epson Premium Photo Paper Semi-gloss

» Epson Ultra Premium Photo Paper Luster

» Epson Velvet Fine Art Paper

» Epson Watercolor Paper Radiant White

» Epson UltraSmooth Fine Art Paper 325 gsm

» Epson Premium Photo Paper Glossy

» Epson Photo Paper Glossy
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Borderless Paper Sizes

* 4 x6inches (102 x 152 mm)

* 5x7inches (127 x 178 mm)

8 x 10 inches (203 x 254 mm)

Letter (8.5 x 11 inches [216 x 279 mm])
11 x 14 inches (279 x 356 mm)

A4 (8.3 x 11.7 inches [210 x 297 mm])
A3 (11.7 x 16.5 inches [297 x 420 mm])
e 13 x 19 inches (330 x 483 mm)

Parent topic: Loading Media

Paper or Media Type Settings - Product Software

For this paper

Select this Paper Type or Media Type setting

Plain paper
Epson Bright White Paper
Epson High Quality Ink Jet Paper

Plain Paper/Bright White Paper

Epson Premium Photo Paper Glossy
Epson Ultra Premium Photo Paper Glossy

Premium Photo Paper Glossy

Epson Photo Paper Glossy

Photo Paper Glossy

Epson Presentation Paper Matte

Presentation Paper Matte

Epson Premium Photo Paper Semi-gloss

Premium Photo Paper Semigloss

Premium Luster Photo Paper (260)
Epson Ultra Premium Photo Paper Luster

UltraPremium Photo Paper Luster

Epson Ultra Premium Presentation Paper Matte

Ultra Premium Presentation Paper Matte
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For this paper

Select this Paper Type or Media Type setting

Epson Premium Presentation Paper Matte

Epson Premium Presentation Paper Matte Double-

sided

Epson Brochure & Flyer Paper Matte Double-sided

Epson Photo Quality Self-adhesive Sheets

Premium Presentation Paper Matte

Epson Velvet Fine Art Paper

Velvet Fine Art Paper

Epson Metallic Photo Paper Glossy

Metallic Photo Glossy

Epson Metallic Photo Paper Luster

Metallic Photo Luster

Epson Hot Press Bright

Hot Press Bright

Epson Hot Press Natural

Hot Press Natural

Epson Cold Press Bright

Cold Press Bright

Epson Cold Press Natural

Cold Press Natural

Epson Exhibition Fiber Paper

Exhibition Fiber Paper

Epson Exhibition Watercolor Paper Textured

Exhibition Watercolor Textured

Epson Watercolor Paper Radiant White

Watercolor Paper - Radiant White

Epson UltraSmooth Fine Art Paper
Epson UltraSmooth Fine Art Paper 325 gsm

UltraSmooth Fine Art Paper

Standard Proofing Paper (240)
Proofing Paper White Semimatte
Standard Proofing Paper Publication
Standard Proofing Paper Commercial

UltraPremium Photo Paper Luster

Epson Exhibition Canvas Matte

Exhibition Canvas Matte

Epson Exhibition Canvas Satin

Exhibition Canvas Satin

Epson Exhibition Canvas Gloss

Exhibition Canvas Gloss

Epson Exhibition Canvas Natural Matte

Exhibition Canvas Natural Matte

Epson Exhibition Canvas Natural Satin

Exhibition Canvas Natural Satin

Epson Exhibition Canvas Natural Gloss

Exhibition Canvas Natural Gloss
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For this paper Select this Paper Type or Media Type setting

Ink jet printable CD or DVD CD/DVD or CD/DVD Premium Surface (front
manual feed tray only)

Posterboard Ultra Premium Presentation Paper Matte (front
manual feed tray only)

Parent topic: Loading Media

Selecting the Paper Settings for Each Source - Control Panel

You can change the default paper size and paper type for each source using the control panel on the
product.

Press the M home button, if necessary.

Select Load Guide.

Select the paper source you want to change.

Select Paper Size.

Select the paper size you loaded.

Select Paper Type.

Select the paper type for the paper you loaded following the guidelines in the link here.
Select OK.

Repeat these steps to select another paper source to change.

© ©® No gk wDdE

Paper or Media Type Settings - Control Panel
Parent topic: Loading Media

Paper or Media Type Settings - Control Panel

For this paper Select this Paper Type setting

Plain paper Plain Paper
Epson Bright White Paper

Epson High Quality Ink Jet Paper
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For this paper

Select this Paper Type setting

Epson Premium Photo Paper Glossy
Epson Ultra Premium Photo Paper Glossy

Prem. Glossy

Epson Photo Paper Glossy

Glossy

Epson Presentation Paper Matte

Presentation Matte

Epson Premium Photo Paper Semi-gloss

Prem. Semigloss

Premium Luster Photo Paper (260)
Epson Ultra Premium Photo Paper Luster

Premium Luster

Epson Ultra Premium Presentation Paper Matte

Ultra Premium Matte

Epson Premium Presentation Paper Matte

Epson Premium Presentation Paper Matte Double-
sided

Epson Brochure & Flyer Paper Matte Double-sided
Epson Photo Quality Self-adhesive Sheets

Presentation Matte

Epson Velvet Fine Art Paper

Velvet Fine Art

Epson Metallic Photo Paper Glossy

Prem. Glossy

Epson Metallic Photo Paper Luster

Premium Luster

Epson Hot Press Bright

UltraSmooth Fine Art

Epson Hot Press Natural

UltraSmooth Fine Art

Epson Cold Press Bright

UltraSmooth Fine Art

Epson Cold Press Natural

UltraSmooth Fine Art

Epson Exhibition Fiber Paper

Premium Luster

Epson Exhibition Watercolor Paper Textured

Watercolor Paper

Epson Watercolor Paper Radiant White

Watercolor Paper

Epson UltraSmooth Fine Art Paper
Epson UltraSmooth Fine Art Paper 325 gsm

UltraSmooth Fine Art
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For this paper Select this Paper Type setting

Standard Proofing Paper (240) Prem. Semigloss
Proofing Paper White Semimatte
Standard Proofing Paper Publication
Standard Proofing Paper Commercial

Epson Exhibition Canvas Matte UltraSmooth Fine Art
Epson Exhibition Canvas Satin Premium Luster
Epson Exhibition Canvas Gloss Premium Luster
Epson Exhibition Canvas Natural Matte UltraSmooth Fine Art
Epson Exhibition Canvas Natural Satin Premium Luster
Epson Exhibition Canvas Natural Gloss Premium Luster

Ink jet printable CD or DVD CD/DVD
Posterboard UltraSmooth Fine Art

Parent topic: Selecting the Paper Settings for Each Source - Control Panel

Selecting the Default Paper Setup Display and Error Notice Settings

You can select default paper setup display and error notice settings that apply to all print jobs using the
control panel on your product.

Note: These settings can be locked by an administrator. If you cannot access these settings, contact
your administrator for assistance.

1. Press the M home button, if necessary.

2. Press the il setup button.
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You see a screen like this:
I¥ Setup

Maintenance

System Adminmistration

Network Status

Print Status Sheet

Select System Administration. Enter the administrator password, if necessary.
Select Printer Settings.

Select Paper Source Settings.

Select Paper Setup Display.

N o g bk w

Select one of these Paper Setup Display options:
« Select On to display the media setup screen when paper is loaded.
» Select Off if you do not want the media setup screen displayed when paper is loaded.

Note: When this setting is off, AirPrint is unavailable.

8. Select Error Notice.
9. Select one of these Error Notice options:

» Select On to display an error if the loaded paper size or paper type differs from the product
settings.

» Select Off if you do not want an error to display.
Note: This setting is turned off automatically if you set the Paper Setup Display setting to Off.

10. When you are finished, press the f home button to exit.
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Parent topic: Loading Media
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Printing from a Computer

Before printing from your computer, make sure you have set up your product and installed its software
as described on the Start Here sheet.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website. If you see a Software Update screen, select Enable automatic checking
and click OK. The update scans your system to see if you have the latest product software. Follow the
on-screen instructions.

Printing with Windows
Printing with OS X

Printing with Windows

You can print with your product using any Windows printing program, as described in these sections.

Selecting Basic Print Settings - Windows

Selecting Print Layout Options - Windows

Selecting Additional Settings - Windows

Printing Your Document or Photo - Windows

Saving, Sharing, and Customizing the Printer Settings
Selecting Default Print Settings - Windows

Changing the Language of the Printer Software Screens
Changing Automatic Update Options

Parent topic: Printing from a Computer

Selecting Basic Print Settings - Windows
Select the basic settings for the photo or document you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.
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3. If necessary, select your product name as the printer you want to use.
Note: You may also need to select Properties or Preferences to view your print settings.

You see the Main tab of your printer settings window:
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Madia Settings
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Papes Sattings

SoUrCe Shat w

S : Letter (8 1/2x 11in} b LUiger Defined,..
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_| Print Preview
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Reset Defouits(r) Show Settings. .. VWersion 5.0
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4. Select the Media Type setting that matches the paper you loaded.

Note: The available media types vary according to the type of black ink currently selected. If the
Media Type setting you want to use is unavailable, you may need to select a different Ink option.
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5. Ifyou are using non-Epson paper or media and you need to fine-tune its performance, click the
Paper Config button and select paper configuration options as necessary.

6. Selectan Ink option:
» To print using the previous print job's setting, select Last-Used.
« Select the Photo Black Ink or Matte Black Ink setting according to the media type you are using.

Note: To avoid changing black ink more often than necessary, you can set the default black ink type
to the one you usually use. See the link at the end of these steps.

7. Selecta Color option:
» To print a color document or photo, select the Color setting.

« To print text and graphics in black or shades of gray, select the Advanced B&W Photo or
Grayscale setting.

8. Forthe Print Quality setting, select Speed, Quality, or Max Quality, or select Quality Options and
choose the quality option that matches the print quality you want to use.

9. Select the desired color management option as the Mode setting.
10. Select the Source setting that matches the paper feeding method you are using.
11. Select the size of the paper you loaded as the Size setting.

Note: You can also select the User-Defined setting to create a custom paper size.
12. If you are printing a borderless photo, select Borderless.

Note: You must select a compatible borderless paper type and size to print without borders. Check
the borderless paper compatibility list for details.

13. To see a preview of how your document or photo will print, select Print Preview. (The preview
appears after you click Print but before printing starts.)

14. To layout multiple print jobs for printing all at once, select Layout Manager.

Paper Configuration Options - Windows
Advanced B&W Photo Options - Windows
Print Quality Options - Windows

Color Management Options - Windows
Advanced Color Controls - Windows
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Paper Source Options - Windows
Using Layout Manager - Windows Only

Parent topic: Printing with Windows

Related concepts
Switch Black Ink Type

Related references
Double-sided Printing Options - Windows
Black Ink Type Media List

Related tasks
Printing Your Document or Photo - Windows

Paper Configuration Options - Windows
Select any of the available Paper Configuration options to fine-tune the quality of your print.

Paper Configuration
Color Density
.. ...... +0 | (%)
-50 50
Drying Time per Print Head Pass
0 | (0. 1=ec)
0 S0
Paper Thickness: |3 | (0. 1mm)
Platen Gap Standard W
Default i oK | | Cancel Help

Color Density
Adjusts the ink saturation level.
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Drying Time per Print Head Pass
Pauses print head movement for up to 5 seconds after each pass to allow ink to dry. This lets you
print with non-Epson media and avoid smearing the ink.

Paper Thickness
Lets you select the thickness of your paper or media.

Platen Gap
Adjusts the distance from the paper to the print head.

Parent topic: Selecting Basic Print Settings - Windows
Advanced B&W Photo Options - Windows

If you select Advanced B&W Photo as the Color option, you can easily produce neutral and toned
black-and-white prints. Whether your photo is color or grayscale, you can use this screening and color
management technology to create stunning black-and-white prints. You can select any of the available
options.

Color Toning
Adds tone (hue) to your black-and-white output. The default is Neutral, which provides a neutral tonal
scale print. You can also choose other popular presets such as Cool, Warm, and Sepia. Note that
the presets affect the target found in the tone color circle.

Tone
Changes the entire tonal scale of your black-and-white output. While Darker is the default setting, you
may see better results if you choose Dark. The tone color circle adjusts the hue of your black-and-
white print. Click on any portion of the color wheel or enter corresponding values to customize the
tone (hue) to add to your print. The closer you select to the edge of the wheel, the more color you add.

Brightness
Adjusts the overall lightness and darkness of your image.

Contrast
Adjusts the difference between the light and dark areas of your image.

Shadow Tonality
Controls tonality only in the shadow areas of your image.

Highlight Tonality
Controls tonality only in the highlight areas of your image.

Max Optical Density
Adjusts the overall density or focus of the print. Create a soft focus print by lowering the density
setting.

Highlight Point Shift
Helps reduce gloss differential on glossy media by adding density to the highlights of your image.
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Parent topic: Selecting Basic Print Settings - Windows
Print Quality Options - Windows

You can use the Speed/Quality slider to set the desired quality level, and select any of the available
Quality options to fine-tune the quality of your print. Some settings may be unavailable, depending on the
paper type and border setting you have chosen.

High Speed
Speeds up printing but may reduce print quality.

Edge Smoothing
Smooths jagged edges in low-resolution images such as screen captures or images from the Web.

Finest Detail
Sharpens edges on vector-based data including text, graphics, and line art. (This setting does not
affect photographs.)

Parent topic: Selecting Basic Print Settings - Windows
Color Management Options - Windows

You can adjust the Mode setting to fine-tune the colors in your printout, or turn off color managementin
your printer software.

EPSON Standard (sRGB)

Increases the contrast in images. Click the Advanced Color Settings tab to use advanced color
controls.

Adobe RGB
Matches image colors to the Adobe RGB color standard. Use this setting if your source file was
captured in Adobe RGB. Click the Advanced Color Settings tab to use advanced color controls.

PhotoEnhance
Lets you choose from various Scene Correction settings to automatically analyze your photos and, if
necessary, adjusts the brightness, contrast, and saturation.

Note: PhotoEnhance uses a sophisticated face recognition technology to optimize photos that include
faces. For this to work, both eyes and the nose must be visible in the subject's face. If your photo
includes a face with an intentional color cast, such as a statue, you may want to turn off
PhotoEnhance to retain the special color effects.

ICM
Automatically adjusts colors based on the printer’s ICC profile and the selected Media Type setting,
using the Image Color Matching system. Click the Advanced button to choose the input profile and
other settings.
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Note: In most cases, you get better results by applying color management in your application, rather
than in the printer driver.

Off (No Color Adjustment)

Turns off color management in your printer software so you can manage color using only your
application software.

Parent topic: Selecting Basic Print Settings - Windows
Advanced Color Controls - Windows

If you selected EPSON Standard (RGB) or Adobe RGB as the Mode setting, you can click the
Advanced button to select detailed settings.

Color Contrals
Ermiter Color Adjustment
Mede EPSON Standard (s05) 5 Color Adpstment Method
P o = ) Color Circle: Shele Blay

Copfrast 4

Gaturation

[efaudt (.3 Carogd Heio

The Color Controls screen lets you specify values for adjusting brightness, contrast, saturation, and
individual Cyan, Magenta, and Yellow color tones. You can choose from two Printer Color Adjustment
modes and two Gamma settings, and use either a color circle or slide bar to adjust color.

Parent topic: Selecting Basic Print Settings - Windows
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Paper Source Options - Windows

You can select any of the available options in the paper Source menu to print on the paper loaded in that
source.

Sheet
Selects sheets of paper loaded in the sheet feeder.

Roll Paper
Selects roll paper loaded in the roll paper holder for photos or panoramics up to 27 inches (68.6 cm)
long. Click Print page frame to print a cutting guideline around each photo.

Roll Paper (Banner)
Selects roll paper loaded in the roll paper holder for photos or banners over 27 inches (68.6 cm) long.

Front - Fine Art
Selects fine art paper loaded in the front manual feed tray.

Front - Poster Board
Selects poster board or other thick media loaded in the front manual feed tray.

CD/DVD Tray
Selects the CD or DVD loaded in the CD/DVD tray.

Parent topic: Selecting Basic Print Settings - Windows
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Using Layout Manager - Windows Only

Layout Manager lets you create a poster or display by dragging multiple pieces of print data created in
different applications onto one sheet of paper for printing.

Soaren | Than
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You can also place the same print data multiple times as shown here.
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You can place print data in different sizes and orientations to maximize media usage, as shown here.
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You can place print data on roll paper as shown here.

2
|
2
3
i
i
i |
2

1. Open the file you want to print in your application.
2. Select the print command in your application.
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Select Layout Manager on the Main tab and choose an option for Size that matches the size of the
document in the application.

= Mon |[1] Page Layout | 7 Uity

Select Settng : | Current Settings W Save/Dal...
Media Sattings
Paper Settings
Sige Letter (8 1/2x 11in) W Liger Defined...
Ink Levela

P

Y WM LC Y™ C LUK IK
Reset Defaults(r) Show Settings.... Wersion 5. 70

0K Cancal Hslp:

Note: You select the size of the paper you are printing on in a later step.

Click OK.
The Layout Manager screen opens and displays one page in the layout.

Leave the Layout Manager screen open and repeat steps 1 to 4 to arrange additional print data. The
pages are added to the Layout Manager screen.
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6. Do the following to arrange objects on the Layout Manager screen:
» Drag pages to move and resize them.
» Use tool buttons and the Object menu to align and rotate pages.
* Resize and replace whole pages in the Preference or Arrangement Settings screens.

Note: See the Layout Manager screen help for more details.

Click File > Properties, then select your print settings on the Main tab.
Click the File menu on the Layout Manager screen and click Print.

Note: To save the current job to a file, click the File menu on the Layout Manager screen, save the
file, and close the Layout Manager screen. To open the saved file later for editing or reprinting, right-
click the printer icon in the Windows taskbar, select Layout Manager, and open the file.

Parent topic: Selecting Basic Print Settings - Windows
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Selecting Print Layout Options - Windows
You can select a variety of sizing and layout options for your document or photo on the Page Layout tab.

- | x|

& Wain || Page Layout| & Uiy

Sglect Setting : Cunrent Settings W SaveDel...
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Output Paper 1 | 5ame as Paper Sine W
|| Reduce Enlarge |_] phudes-Prage
[ soubde-Sided Printing(2) +f] Optimize Enlargement
[ Prinit Bickg Color
| Job Settings
Reset Defaults(Y) Show Setbngs... Wersion 8.
DK Concet Help

» To change the orientation of your printed document or photo, select the Portrait or Landscape
checkbox.

» To rotate or flip the printed image, select the Rotate 180° or Mirror Image checkbox.

» To select multiple copies and their print order, select the Copies, Collate, and Reverse Order
options.
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» To change the size of your printed document or photo, select the Reduce/Enlarge checkbox and
select sizing options.

» To print multiple pages on one sheet of paper, or print one image on multiple sheets of paper, select
the Multi-Page checkbox and select the options you want.

» To print on both sides of your paper, select the Double-Sided Printing options.

Note: Your product software prompts you to reinsert your paper when it is time to print on the reverse
side.

» To enlarge your image beyond the limits of your application program, select Optimize Enlargement.

Note: The driver can increase the image size up to 650% and decrease the output resolution to stay
within the pixel limitations. Depending on the resolution of the original image and the print size, you
may see reduced print quality.

» To print a color background on the page, select Print Bckg Color and click Color Settings to select
the color you want to use.

» To print the time, date, and other information about your print job at the top or bottom of the page,
select Job Settings and click Details to select the settings you want to use.

Reduce/Enlarge Options - Windows
Multi-Page Printing Options - Windows
Double-sided Printing Options - Windows
Parent topic: Printing with Windows
Reduce/Enlarge Options - Windows
You can select any of the Reduce/Enlarge options to size your printed image.

Fit to Page
Sizes your printed image to fit on the paper you loaded and selected as the Output Paper setting.

Fit to Roll Paper Width
Sizes your printed image to fit the width of the roll paper you loaded.

Custom
Sizes your printed image by the percentage you select as the Scale to setting.

Parent topic: Selecting Print Layout Options - Windows
Multi-Page Printing Options - Windows
You can select these Multi-Page options to set up your multi-page print job.
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N-up
Prints 2 (2-up) or 4 (4-up) pages on one sheet of paper.

Poster

Prints one image on multiple sheets of paper to create a large poster with or without borders. Click the
Settings button to select the layout and guideline options.

Parent topic: Selecting Print Layout Options - Windows
Double-sided Printing Options - Windows
You can select any of the double-sided options to set up your double-sided print job.

Margins
Click Margins to customize the margins used during double-sided printing.

Binding Edge Options
Select a setting that orients double-sided print binding in the desired direction.

Binding Margin Options
Select options that define a wider margin to allow for binding.

Folded Booklet Option
Select a binding option to use when creating a folded booklet.

Parent topic: Selecting Print Layout Options - Windows

Selecting Additional Settings - Windows

You can run maintenance utilities and select additional settings that apply to all the print jobs you send to
your product.

1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
3. Click the Utility tab.
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You see a window like this:
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4. Select any of the following options, as necessary:

* Nozzle Check to print a nozzle check pattern to check whether the print head nozzles are
clogged.

« Head Cleaning to clean the print head if you notice banding or gaps in your printouts.

« Print Head Alignment to align the print head if printouts appear grainy or out of focus.
e Epson Status Monitor 3 to check the printer's status.
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« Monitoring Preferences to select the error notifications displayed on the Epson Status Monitor 3
screen, or add a shortcut to the utility in the Windows taskbar.

« Print Queue to display a list of all waiting print jobs, view information on the data waiting to be
printed, and delete or reprint the jobs.

« Language to select the language you want to use for the printer software screens.
« Printer and Option Information to set the time to turn off the printer automatically.
» Speed and Progress to select various printing options.

« Menu Arrangement to arrange the Setting, Media Type, and Paper Size options by frequency of
use.

« Export or Import to save the print settings to a file or import them from a file. This is useful when
you want to select the same print settings on multiple computers.

« Driver Update to check the Epson website for any available printer software updates and install
them automatically.

5. Click OK to close the printer software window.
Parent topic: Printing with Windows

Related tasks
Printing Your Document or Photo - Windows

Printing Your Document or Photo - Windows
Once you have selected your print settings, you are ready to save your settings and print.
1. Click OK to save your settings.
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You see your application's Print window, such as this one:

ol Print “

General

Select Prirder

I EPSON |
= Fax
= Microsoft XPS Document Winter

Sstus: Rizady [ |Pirttafile | Preferences
Location
Coenmert Fing Printer
Fags Range
A Mumber of goples: |1 15
- gl g2l g3
Prirt Cancel

2. Click OK or Print to start printing.
Checking Print Status - Windows
Parent topic: Printing with Windows
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Checking Print Status - Windows

During printing, you see this window showing the progress of your print job. It allows you to control
printing and check ink cartridge status.

- EPSOM - UISEOON - B

EPED_M il e Dby [
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» To cancel printing, click Cancel.
» To see print jobs waiting to print, click Print Queue.
Parent topic: Printing Your Document or Photo - Windows

Saving, Sharing, and Customizing the Printer Settings

You can save groups of print settings or media settings so you can reuse them for future print jobs. You
can export these settings as a file so you can share them with other users. You can also edit the settings
displayed in the printer software screens.

Saving and Sharing Print Settings - Windows
Saving and Sharing Media Settings - Windows
Editing Print Setting Displays - Windows
Parent topic: Printing with Windows
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Saving and Sharing Print Settings - Windows
You can save your print settings so you can use them for future print jobs.
1. Selectthe print settings you want to save.
2. Click Save/Del at the top of the Main or Page Layout tab in your printer software.
You see a window like this:

Saves or Deletes Select Settings
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Privd Quaity Level  LEVEL 3 {Speed)
Prind Qualiby SuperFine - 14
Bame ; High Speed on
- s Fnget Oatad oid

Edge Smoodhing  Off
Color Adpeiment EPFGON Stancar. ..

Sethrg Ceefaat Setong
Source Sheet
Borderiess ot
Sy Letter (B 438 .. -
Crientaiion Forirat
Aokate BE* off
Mirvor [rage ol
Time Coped i w
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3. Verify that your settings are correct, enter a name for the group of settings in the Name field, and
click Save.

Note: If you need to delete a group of settings you have created, select the name of the group of
settings from the list and click Delete.

4. Do the following as necessary:
« Select the name of the group of settings from the Select Setting list and use them to print.

« To export the settings, click Save/Del, select the name of the group of settings, click Export,
select a location, and enter a file name.
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« To import a group of settings, click Save/Del, click Import, select the file you want to use, and
click Open. Then use the settings to print.

Parent topic: Saving, Sharing, and Customizing the Printer Settings
Saving and Sharing Media Settings - Windows

You can save and share settings you have selected for a particular media type so you can use them for
future print jobs.

1. Selectthe Media Settings you want to save on the Main tab, as necessary.
2. Click Custom Settings.
You see a window like this:

Saves or deletes Custom Media
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3. Verify that your settings are correct, enter a name for the media settings in the Name field, and click
Save.

Note: If you need to delete a group of settings you have created, select the name of the settings
from the list and click Delete.
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4. Do the following as necessary:
« Select the name of a media setting as the Media Type setting and use it to print.

» To export the settings, click Custom Settings, select the name of the media settings, click
Export, select a location, and enter a file name.

< To import settings, click Custom Settings, select the name of the media settings, click Import,
select the file you want to use, and click Open. Then use these settings to print.

Parent topic: Saving, Sharing, and Customizing the Printer Settings
Editing Print Setting Displays - Windows
You can arrange the displayed print settings so you can easily select the settings you use most often.
1. Click the Utility tab in the printer software.
2. Select Menu Arrangement.
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You see this window:

Menu Arrangement

Edit Item
©Bdkdseiing OliedoTyoe  OaperSie

List ¢
Photo
| Fine Art
Paster
Others
© not Display

Add Group... slete Grouy Resat

s ' Cancel Help

3. Select the item you want to edit.
4. Order or group items in the List box.
* To move and reorder items, drag and drop them in the list.
« To add a new group (folder), click Add Group.
« To delete a group (folder), select the group and click Delete Group.
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« To hide a group, drag and drop it to Not Display.

Note: If you delete a group, the group folder is deleted but the items within the folder remain.

5. Click Save.

Parent topic: Saving, Sharing, and Customizing the Printer Settings

Selecting Default Print Settings - Windows

When you change your print settings in a program, the changes apply only while you are printing in that

program session. If you want to change the print settings you use in all your Windows programs, you can
select new default print settings.

1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.
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You see the printer settings window:
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3. Select the print settings you want to use as defaults in all your Windows programs.
4. Click OK.

These settings are now the defaults selected for printing. You can still change them as needed for
printing in any program session.

Parent topic: Printing with Windows

99



Changing the Language of the Printer Software Screens
You can change the language used on the Windows printer software screens.

1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Printer Settings.

You see the printer settings window.
3. Click the Utility tab.

You see these options:
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4. Select the language you want to use as the Language setting.
5. Click OK to close the printer software window.

The printer software screens appear in the language you selected the next time you access them.
Parent topic: Printing with Windows

Changing Automatic Update Options

Your printer software for Windows automatically checks for updates to the product software. You can
change how often the software checks for updates or disable this feature.

1. Access the Windows Desktop and right-click the product icon in the Windows taskbar.
2. Select Software Update Settings.
You see this window:

Software Update Settings “
Check for Software Updates on the Internet
(@) Chedk every 2 weeks W
I Mever
oo 1 [ conce

3. Do one of the following:

» To change how often the software checks for updates, select a setting in the Check every menu.
» To disable the automatic update feature, select the Never option.
4. Click OK to exit.

Note: If you choose to disable the automatic update feature, you can check for updates manually.

Parent topic: Printing with Windows
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Related tasks
Checking for Software Updates

Printing with OS X

You can print with your product using any OS X printing program, as described in these sections.

Note: If you have an Internet connection, it is a good idea to check for updates to your product software
on Epson's support website.

Selecting Basic Print Settings - OS X
Selecting Roll Paper Settings - OS X
Selecting Paper Configuration Settings - OS X
Selecting Print Layout Options - OS X
Managing Color - OS X

Sizing Printed Images - OS X

Selecting Printing Preferences - OS X

Printing Your Document or Photo - OS X

Parent topic: Printing from a Computer

Selecting Basic Print Settings - OS X
Select the basic settings for the photo or document you want to print.
1. Open a photo or document for printing.
2. Select the print command in your application.

Note: You may need to select a print icon on your screen, the Print option in the File menu, or
another command. See your application's help utility for details.
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Select your product as the Printer setting.

Printer: | EPSON

ik

Presets: | Default Settings

Coples: |1 %
Pages: | All :

If necessary, click the arrow next to the Printer setting or the Show Details button to expand the
print window.

You see the expanded printer settings window for your product:

@

Printer: | EPSON

Presets: | Default Settings

Copies: |1

Pages: (=) All
From: |1 to: |1
Paper Size: | U5 Letter * | 8.50 by 11.00 inches
Orlentation: [ri It

Preview :

M Aute Rotate

=) Scale; 100 %

Scale to Fit; =

Copies per page: | 1

Cancel | | Print |
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Note: The print window may look different, depending on the version of OS X and the application
you are using.

Select the Copies and Pages settings as necessary.

Note: If you do not see these settings in the print window, check for them in your application before
printing.
Select the size of the paper you loaded as the Paper Size setting.

» To print a borderless photo, select the Borderless checkbox or a paper size with a Borderless
option. You can also create a custom paper size, but the highest available Quality setting is
limited to Normal.

e To print on roll paper, select a roll paper size or one with a Borderless option. To print on roll
paper in a custom size, see the link at the end of these steps.

Note: You can reduce or enlarge the size of the printed image by selecting Paper Handling from the
pop-up menu and selecting a scaling option.

Note: If you do not see these settings in the print window, check for them in your application before
printing. They may be accessible by selecting Page Setup from the File menu.

Choose portrait or landscape as the Orientation setting.

Select any application-specific settings that appear on the screen, such as those shown in the image
above for the Preview application.
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9. Select Printer Settings from the pop-up menu.

Preview

Layout

Color Matching
Paper Handling
Cover Page

¥ Printer Settings

Roll Paper Settings
Advanced Media Control

Supply Levels
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You see these settings:

Printer Settings

Advanced Color Settings |

Media Type: | Premium Photo Paper Glossy B
Ink: Phota Black
Print Mode: = AccuPhoto HD :

Color Mode: | EPSON Standard (sRGE)
Output Resolution: | SuperFine - 1440 dpi =

v Hi gh Speed
| Mirror Image

Cancel Print

10. Select the type of paper you loaded as the Media Type setting.

Note: The setting may not exactly match the name of your paper. Check the media type settings list
for details.

11. Select one of the following as the Print Mode setting:
¢ Select AccuPhoto HD for any type of photographic printing.

» Select Advanced B&W Photo to print black-and-white photos on certain types of photo paper.
See the list of Advanced B&W Photo options for details. If your paper type does not support this
option, print black-and- white photos using the AccuPhoto HD setting.

12. Click Color Mode and select Manual Settings.
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13. Select one of the following as the Color Mode setting:

« EPSON Standard (sRGB)
Increases the contrast in images. Click the Advanced Color Settings tab to use advanced
color controls.

* Adobe RGB
Matches image colors to the Adobe RGB color standard. Use this setting if your source file was
captured in Adobe RGB. Click the Advanced Color Settings tab to use advanced color
controls.

e Off (No Color Adjustment)
Turns off color management in your printer software so you can manage color using only your
application software.

Note: If desired, you can instead use ColorSync to manage colors. In most cases, you get better
results by applying color management in your application, rather than in the printer driver.

14. Select the Output Resolution setting you want to use.
15. Select any of the available print options.

Advanced Color Settings - OS X
Output Resolution Settings - OS X
Print Options - OS X

Parent topic: Printing with OS X

Related references
Paper or Media Type Settings - Product Software

Related tasks
Printing Your Document or Photo - OS X
Selecting Roll Paper Settings - OS X

Advanced Color Settings - OS X

When you click the Advanced Color Settings tab, you see one of the screens below depending on the
Print Mode you selected.

 AccuPhoto HD
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You can specify values for adjusting brightness, contrast, saturation, and individual Cyan, Magenta,
and Yellow color tones.

1 Printer Settings % |
S W Advanced Color Settings S
Color Mode: | EPSON Standard (sRGB) &)
Gamma: | 2.2 :|
Brightness: 0 ] 9,
Contrast: 0 () .
Saturation: t}_ - Q
Cyan: 0 . 9,
Magenta: .E}__. L} »
Yellow: 0 )
| Cancel | 1 Print

» Advanced B&W Photo
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You can select any of the available options.

| Printer Settings : ]

Brightness: 0 | —L
Contrast: [0 | =——1{ ——
Shadow Tonality: 0 | — 1
Highlight Tonality: 0 |~ /=~

Max Optical Density: |0 e

Tone:
| Dark
Hortzontal  yughiight point shife:
| o |_:J| o ST
Vertical: 5 5
o {3

| Cancel | | Print

Color Toning
Adds tone (hue) to your black-and-white output. The default is Neutral, which provides a neutral tonal
scale print. You can also choose other popular presets such as Cool, Warm, and Sepia. Note that
the presets affect the target found in the tone color circle.

Brightness
Adjusts the overall lightness and darkness of your image.

Contrast
Adjusts the difference between the light and dark areas of the overall image.

Shadow Tonality
Controls tonality only in the shadow areas of your image.
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Highlight Tonality
Controls tonality only in the highlight areas of your image.

Max Optical Density
Adjusts the overall density or focus of the print. Create a soft focus print by lowering the density
setting.

Tone
Changes the entire tonal scale of your black-and-white output. While Darker is the default setting, you
may see better results if you choose Dark. The tone color circle adjusts the hue of your black-and-
white print. Click on any portion of the color wheel or enter corresponding values to customize the
tone (hue) to add to your print. The closer you select to the edge of the wheel, the more color you add.

Highlight Point Shift
Helps reduce gloss differential on glossy media by adding density to the highlights of your image.

Parent topic: Selecting Basic Print Settings - OS X

Output Resolution Settings - OS X

You can select any of the Output Resolution settings to fine-tune the quality of your print. Some
settings may be unavailable, depending on the paper type and border setting you have chosen.

Draft
For draft printing on photo paper.

Fine - 720 dpi
For everyday text and image printing.
Super Fine - 1440 dpi
For photos and graphics with good print quality and speed.

Photo - 1440 dpi
For photos and graphics with high print quality and slower speed.

SuperPhoto - 5760 dpi
For the best print quality but the slowest print speed (recommended for canvas media).

Parent topic: Selecting Basic Print Settings - OS X

Print Options - OS X

You can select any of the print options to customize your print. Some options may be unavailable,
depending on other settings you have chosen.

High Speed
Speeds up printing but may reduce print quality.
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Mirror Image
Flips the printed image left to right.

Note: Turn off High Speed when printing on canvas media.
Parent topic: Selecting Basic Print Settings - OS X

Selecting Roll Paper Settings - OS X

To print on roll paper, you select the roll paper size and roll paper options from the Printer Settings
menu.

1. Select Manage Custom Sizes as the Paper Size setting.
2. Click +, double-click Untitled, and enter a name for your roll paper size.
3. Enter one of the following as the Width setting:

» 8.3 for 8.3-inch (211 mm) wide roll paper

e 12.95 for 13-inch (330 mm) wide roll paper

Note: Make sure your image fits within the width of your roll paper.

Enter the length of your roll paper image as the Height setting (up to 44 inches [1118 mm]).
Set the margin setting to 0.

Click OK.

Select your new custom roll paper size as the Paper Size setting.

© N o g &

Select Roll Paper Settings.
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You see this window:

ik

Roll Paper Settings

Roll Paper Option
Print page frame

Expansion Min Mid Max

& F

If you move the slider off of the Max setting. you will reduce the amount
of image enlargernent. However, you may sée a white border around your
printed image.

Cancel | Print |

Note: Some settings may not be available, depending on the Roll Paper option you selected for your
Paper Size.

9. Select the following settings as necessary:
« Click Print page frame to print a cutting guideline between images.
< Adjust the amount of image expansion when printing borderless images.

Note: This option is available only when you choose a Paper Size setting with a Borderless
option.

10. Click Print.
Parent topic: Printing with OS X
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Selecting Paper Configuration Settings - OS X

If you are using non-Epson media and need to fine-tune its print quality, select Advanced Media
Control from the pop-up menu. Select the available options as necessary.

Advanced Media Control -

Color Density: 1] :
=50 +50 (%)
Drying Time per Print Head Pass:

0
0 +50 (0.1sec)
Paper Thickness: 3 «| t6 Lenm)
Platen Gap: Standard S
Default
Cancel Print

Advanced Media Control Options - OS X
Parent topic: Printing with OS X
Advanced Media Control Options - OS X
Select any of the available Advanced Media Control options to fine-tune the quality of your printouts.

Color Density
Adjusts the ink saturation level.

Drying Time per Print Head Pass
Pauses print head movement for up to 5 seconds after each pass to allow ink to dry. This lets you
print with non-Epson media and avoid smearing the ink.

Paper Thickness
Lets you select the thickness of your paper or media.

Platen Gap
Adjusts the distance from the paper to the print head.

113



Parent topic: Selecting Paper Configuration Settings - OS X

Selecting Print Layout Options - OS X

You can select a variety of layout options by selecting Layout from the pop-up menu on the print
window.

Layout s

Pages per Sheet: | 1 :

Border: | None

Reverse page orientation
Flip herizontally

Cancel | | Print |

» To print multiple pages on one sheet of paper, select the number of pages in the Pages per Sheet
pop-up menu. To arrange the print order of the pages, select a Layout Direction setting.

» To print borders around each page on the sheet, select a line setting from the Border pop-up menu.
» Toinvert or flip the printed image, select the Reverse page orientation or Flip horizontally settings.
Parent topic: Printing with OS X

Managing Color - OS X

You can adjust the Color Matching settings to fine-tune the colors in your printout, or turn off color
management in your printer software.
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1. Select Color Matching from the pop-up menu in the print window.

a8

Color Matching

ColorSync (= EPSON Color Controls

2. Select one of the available options.
Color Matching Options - OS X
Parent topic: Printing with OS X
Color Matching Options - OS X
You can select from these settings on the Color Matching menu.

ColorSync
Prints using standard color profiles for your product and paper to help match image colors. You can

customize the conversion method and filter settings on the ColorSync pop-up menu in the print
window.

EPSON Color Controls
Lets you manage color using controls in your printer software or turn off color management. Select
the option you want to use as the Color Mode setting.

Parent topic: Managing Color - OS X

Related tasks
Selecting Basic Print Settings - OS X
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Sizing Printed Images - OS X

You can adjust the size of the image as you print it by selecting Paper Handling from the pop-up menu
on the Print window.

Paper Handling :

IET Collate pages

']

Pages to Print: | All pages

Page Order: | Automatic
(¥ Scale to fit paper size
Destination Paper Size: | Suggested Paper: US Letter -

cale gown anly

Cancel [_Print ]

» To collate multiple copies into sets of documents, select the Collate pages checkbox.

» To print only selected pages in a multi-page document, select an option from the Pages to Print pop-
up menu.

» To adjust the order in which pages are printed, select an option from the Page Order pop-up menu.

» To scale the image to fit on a specific paper size, select the Scale to fit paper size checkbox and
select a paper size from the Destination Paper Size pop-up menu.

» To restrict scaling of the image to reduced sizing, select the Scale down only checkbox. (Deselect
this checkbox when enlarging the image.)

Parent topic: Printing with OS X

Selecting Printing Preferences - OS X
You can select printing preferences that apply to all the print jobs you send to your product.
1. Inthe Apple menu or the Dock, select System Preferences.

2. Select Print & Fax, Print & Scan, or Printers & Scanners, select your product, and select Options
& Supplies.

3. Select Options.
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You see a screen like this:

General Rel0iEHE Supply Levels Uility

To take full sdvartage of vour printer's oplions, canfirm tRat they are sodurabely

showen here. For infosmation on your printer and Its optional hardware, check the
DFATET S GOCUMEnTTEMN

Warning Notfications: | On

Estabdish bidirectional communication: | On

Cancel | Bk

4. Select any of the available printing options.
5. Click OK.
Printing Preferences - OS X
Parent topic: Printing with OS X
Printing Preferences - OS X
You can select from these settings on the Options tab.

Warning Notifications

Lets you choose whether or not to receive warning notifications from the printer software for various
operating conditions.

Establish bidirectional communication

Allows the product to communicate with the computer. Do not change the default setting unless you
experience issues when using a shared printing pool.

Parent topic: Selecting Printing Preferences - OS X

Printing Your Document or Photo - OS X

Once you have selected your print settings, you are ready to print.
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Click Print at the bottom of the print window.

i

| Printer Settings B

. __f._r:lw_.nce_d Euiur_Snettings |
Media Type: | Premium Photo Paper Glossy .
IrLk: Photo Bbacl:
Print Mode: | AccuPhoto HD ]
Color Mode: EPSON Standard (sRGB) |

Output Resolution: | SuperFine - 1440 dpi -

ol High Speed
| Mirror Image

| Cancel Print

Checking Print Status - OS X
Parent topic: Printing with OS X
Checking Print Status - OS X
During printing, you can view the progress of your print job, control printing, and check ink status.
1. Click the printer icon when it appears in the Dock.
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You see the print status window:

8aDo o EPSON

W

Pause 5eMTings

- advanced_color_settings
=
[

2. Select the following options as necessary:
0OS X 10.7:
» To cancel printing, click the print job and click the Delete icon.

« To pause a print job, click the print job and click the Hold icon. To resume a print job, click the print
job marked "Hold" and click the Resume icon.

« To pause printing for all queued print jobs, click the Pause Printer icon.
» To check ink status, click the Supply Levels icon.
OS X 10.8/10.9/10.10:

» To cancel printing, click the I:' button next to the print job.

» To pause a print job, click the |:| button next to the print job. To resume a print job, click the I:l
button.

« To pause printing for all queued print jobs, click the large Pause button.

» To check ink status, click the Settings icon, then click the Supply Levels tab.

Parent topic: Printing Your Document or Photo - OS X
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Printing on CDs/DVDs

Follow the instructions here to print a design onto ink jet-printable CDs or DVDs to create a custom label.
Loading a CD/DVD

Removing a Printed CD/DVD

Printing on CDs/DVDs from a Computer

Loading a CD/DVD

You can use your printer and the Epson Print CD software that came with it to print label designs directly

onto ink jet-printable CDs or DVDs. To prevent errors, you should burn files, music, or video onto your
CD or DVD before printing.

1. Turn on the printer.

2. Remove any roll paper or paper loaded in the sheet feeder. Close the rear support if it's open.
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4. Push the center of the manual feed tray to extend it.
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7. Line up the arrows on the CD/DVD tray with the line on the manual feed tray. Make sure the
CD/DVD tray is flush against the right.

8. Press CD/DVD - Load on the touch screen. The CD/DVD tray loads inside the printer.
Parent topic: Printing on CDs/DVDs

Removing a Printed CD/DVD

After your CD or DVD is printed, the tray ejects partially from the printer. Pull out the tray and remove the
disc.

Note: If you want to remove the CD/DVD tray without printing, press Eject on the touch screen and
follow the on-screen instructions.
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Parent topic: Printing on CDs/DVDs

Printing on CDs/DVDs from a Computer

Before printing directly on CDs or DVDs from your computer, make sure you have set up your product as
described on the Start Here sheet, and installed the Epson Print CD software.

Starting Epson Print CD - Windows
Printing Your CD/DVD Design - Windows
Starting Epson Print CD - OS X

Printing Your CD/DVD Design - OS X

Parent topic: Printing on CDs/DVDs

Starting Epson Print CD - Windows

You can use Epson Print CD to design your disc by importing photos, adding text, and creating special
effects.

1. Selectthe Epson Print CD icon on your Windows Desktop.
You see a screen like this:

T - =]
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2. Use the buttons on the left side of the screen to select a pre-designed template or add a background
image, picture, text, or graphic elements. For more information, select the Help menu.

3. When you are finished creating your design, click Save and save your design file.
Parent topic: Printing on CDs/DVDs from a Computer

Printing Your CD/DVD Design - Windows

After you create your design, you can print it on paper to test it, then print it on the CD or DVD that
contains your data, photos, video, or music. Make sure the disc is loaded for printing before you start.

1. Openyour file in Epson Print CD and click Print.
You see a screen like this:

Print [ x |
Printar Epson ¥
Copies
Me-dia Tipe COoVD ¥.
Prind Color Comedion ket el Pl N
¥51 Prind Position o
Lighbes Doafasit Darker - 8
5 ] 1 0 =1 +2 +3

Prird Confirmation Pafiem
: Adgust Prink Position
® MNone

Print Dengity Confirmabion Patbern Tray

-
Manual Prinm

Print Positipn Confemnaton Faiem

Test Print

Frint Canos Help

2. Make sure your product is selected as the Printer setting.

To see how your design will look without printing on the disc, click Test Print and follow the
instructions on the screen.

4. When you are ready to print on the disc, click the Print button on the screen.
5. Click Print.
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Note: If you need to adjust the print position or print quality, see the Epson Print CD Help utility for
instructions.

Parent topic: Printing on CDs/DVDs from a Computer

Starting Epson Print CD - OS X

You can use Epson Print CD to design your disc by importing photos, adding text, and creating special

effects.
1. Openthe Epson Print CD program in the Applications > Epson Software > Print CD folder on your
Mac.

You see a screen like this:

8.0.0 Untitlad
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2. Use theicons on the left side of the screen to add a background image, picture, text, or graphic
elements.

3. When you are finished creating your design, make sure you save it.

125



Parent topic: Printing on CDs/DVDs from a Computer

Printing Your CD/DVD Design - OS X

After you create your design, you can print it on paper to test it, then print it on the CD or DVD that
contains your data, photos, video, or music. Make sure the disc is loaded for printing before you start.

1. Openyour file in Epson Print CD and select Print from the File menu.
You see a screen like this:

Print

Select Printer Manual Print
Frinter: EpSOM Test Pring
Coples: |1

Media Type: CD/DVD

Celor Correction Adjust Print Posigion
Light Standard Strang Horizontal 0.0 mm
= Wertical 0.0 mm

-3 -2 -1 0 +1 #2 +3 Pasition Adjustment

Fring Check Fatem
(=) None
Print Density Check Pattern Tray

Fosition |

Print Pasition Check Pattern | |

Cancel Print

2. Make sure your product is selected as the Printer setting.

To see how your design will look without printing on the disc, select Test Print and follow the
instructions on the screen.

4. When you are ready to print on the disc, click the Print button on the screen.

Note: If you need to adjust the print position or print quality, see the Epson Print CD Help utility for
instructions.

Parent topic: Printing on CDs/DVDs from a Computer
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Replacing Ink Cartridges

When an ink cartridge is expended, you need to replace it.

You may also need to replace a cartridge that is more than six months old, or if your printouts do not look
their best, even after cleaning and aligning the print head.

Note: Please dispose of your used Epson branded ink cartridges responsibly and in accordance with
local requirements. If you would like to return your used ink cartridges to Epson for proper disposal,
please go to epson.com/recycle for more information.

Check Cartridge Status

Purchase Epson Ink Cartridges
Removing and Installing Ink Cartridges
Switch Black Ink Type

Check Cartridge Status

Your product and its printing software will let you know when an ink cartridge is low or expended.

Checking Cartridge Status on the LCD Screen
Checking Cartridge Status with Windows
Checking Cartridge Status with OS X

Parent topic: Replacing Ink Cartridges

Checking Cartridge Status on the LCD Screen

When one of your cartridges is low or expended, your product's LCD screen displays an error message.
You can also check the cartridge status at any time, as described here.

1. Pressthe f home button.

2. Pressthe I remaining ink display button.
You see the Ink Levels screen.
3. For more information, select Cartridge Information at the bottom of the screen.

Note: The displayed ink levels are approximate.

Parent topic: Check Cartridge Status
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Related tasks
Removing and Installing Ink Cartridges

Checking Cartridge Status with Windows

A low ink reminder appears if you try to print when ink is low, and you can check your cartridge status at
any time using a utility on your Windows computer.

1. To check your cartridge status, access the Windows Desktop and double-click the producticon in
the Windows taskbar.

You see this window:

- EPSON Status Mesdtar 3 @ EPSON =

EPSON "
|2 m e easty b2 st ‘—
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2. Replace or reinstall any ink cartridge indicated on the screen.

Note: If any of the cartridges installed in the product are broken, incompatible with the product
model, or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

3. Todisable the low ink reminder, right-click the product icon in the Windows taskbar and select
Monitoring Preferences.

128



You see this window:

Monitoring Preferences : EPSON
Select Notificabon
Event Sereen Notification A
& Error On
[ Communication Error Off
& Printer Selection Error On
O Ink Low Off N
Default
Select Shortout Icon

[ Register the shortcut icon to the taskbar

Double-dicking the Shortout Icon
opens the Printer Status Window,

[] aliow monitoring of shared printers
[+ 5ee Low Ink Reminder alerts
[] Display Epson Offers
Cancsl Help

4. Deselectthe See Low Ink Reminder alerts checkbox at the bottom of the screen.
5. To disable promotional offers, deselect the Display Epson Offers checkbox.
Parent topic: Check Cartridge Status

Related tasks

Removing and Installing Ink Cartridges
Checking Cartridge Status on the LCD Screen
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Checking Cartridge Status with OS X
You can check your cartridge status using a utility on your Mac.

1. Inthe Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and select
Open Printer Utility.

2. Select EPSON Status Monitor.
You see a window like this:

i

Buy Epson Ink

EPSON evson

ﬁ EPSON Status Maonitor

Ink Levels

SN HARE

Tl Wi Li Lo L R Lya® L L a0 B Wpme B
TreaL LEL ] LEy il T TTEos LB 2 LF) o |

Active Black Ink Mode = Phote Black

Infarmation

Update OK

3. Do the following as necessary:
* To update the ink cartridge status, click Update.
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« Replace or reinstall any ink cartridge indicated on the screen.

Note: If any of the cartridges installed in the product is broken, incompatible with the product model,
or improperly installed, Epson Status Monitor will not display an accurate cartridge status.

Parent topic: Check Cartridge Status

Related tasks
Removing and Installing Ink Cartridges
Checking Cartridge Status on the LCD Screen

Purchase Epson Ink Cartridges

You can purchase genuine Epson ink and paper at Epson Supplies Central at epson.com/ink3 (U.S.
sales) or epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller.
To find the nearest one, call 800-GO-EPSON (800-463-7766).

Note: We recommend that you use genuine Epson cartridges and do not refill them. The use of other
products may affect your print quality and could result in printer damage.

The cartridges included with the printer are designed for printer setup and not for resale. After some ink
is used for priming, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Ink Cartridge Part Numbers

Parent topic: Replacing Ink Cartridges

Ink Cartridge Part Numbers
Use these part numbers when you order or purchase new ink cartridges.

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Ink color Part number
Photo Black 760
Cyan 760
Vivid Magenta 760
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Ink color Part number
Yellow 760
Light Cyan 760
Vivid Light Magenta 760
Light Black 760
Matte Black 760
Light Light Black 760

Parent topic: Purchase Epson Ink Cartridges

Removing and Installing Ink Cartridges

Make sure you have your replacement cartridges handy before you begin. You must install new
cartridges immediately after removing the old ones.

Caution: Leave your old cartridges in the printer until you are ready to replace them to prevent the print
head nozzles from drying out. Do not open ink cartridge packages until you are ready to install the ink.
Cartridges are vacuum packed to maintain reliability.

1. Turn on your product.
2. Lift up the printer cover.
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3. Press the latch and open the ink cartridge cover as shown.

4. Squeeze the tab on the cartridge and lift the cartridge straight up to remove it.

Note: Dispose of used cartridges carefully. Do not take the used cartridge apart or try to refill it.

Warning: If ink gets on your skin, wash it thoroughly with soap and water. If ink gets into your eyes,
flush them immediately with water. If ink gets into your mouth, spit it out and see a doctor right away.
Keep ink cartridges out of the reach of children.
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5. Gently shake the new cartridge four or five times as shown. Then remove the cartridge from the
package and remove the yellow tape from the bottom of the cartridge.

Caution: Cartridges may make a clicking sound when you shake them. Do not remove any labels or
seals, or ink will leak. Do not touch the green chip on the cartridge.

6. Insert the new cartridge into the holder and push it down until it clicks into place.
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7. Close the cartridge cover and push it down until it clicks into place.

8. Close the printer cover.

Note: Wait for your product to check the ink cartridges and charge the ink delivery system, if necessary.
Do not turn off the product during ink priming.

Caution: If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and
store it in the same environment as the printer. The valve in the ink supply port is designed to contain

any excess ink, but do not touch the ink supply port or surrounding area. Always store ink cartridges with
the label facing up; do not store cartridges upside-down.

Parent topic: Replacing Ink Cartridges

135



Switch Black Ink Type

Your product comes with Matte Black and Photo Black ink cartridges. Although both cartridges must be
installed for your product to work, it can print using only one type of black ink at a time. Your product
switches the black ink type automatically, depending on the type of media you load. Because this
process consumes some ink, so you should avoid switching black ink more often than necessary and
select a default black ink type for the type of media you print on most often.

Black Ink Type Media List
Switching the Black Ink Type

Parent topic: Replacing Ink Cartridges

Black Ink Type Media List

To conserve ink, select the default black ink type that matches the type of media you usually print on.

Matte Black Ink Media Types

Epson Presentation Paper Matte

Epson Premium Presentation Paper Matte
Epson Premium Presentation Paper Matte Double-sided
Epson Ultra Premium Presentation Paper Matte
Epson Velvet Fine Art Paper

Epson Exhibition Watercolor Paper Textured
Epson Watercolor Paper Radiant White

Epson UltraSmooth Fine Art Paper 325 gsm
Epson Exhibition Canvas Matte

Epson Exhibition Canvas Natural Matte

Epson Photo Quality Self-adhesive Sheets
Epson Hot Press Bright

Epson Hot Press Natural

Epson Cold Press Bright

Epson Cold Press Natural
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Photo Black Ink Media Types

» Epson Photo Paper Glossy

» Epson Premium Photo Paper Glossy

» Epson Ultra Premium Photo Paper Glossy
» Epson Premium Photo Paper Semi-gloss
» Epson Ultra Premium Photo Paper Luster
» Epson Exhibition Canvas Satin

» Epson Exhibition Canvas Natural Satin

» Epson Exhibition Canvas Natural Gloss

» Epson Exhibition Fiber Paper

» Epson Metallic Photo Paper Glossy

» Epson Metallic Photo Paper Luster
Parent topic: Switch Black Ink Type

Switching the Black Ink Type

Switching the black ink type takes several minutes and consumes some ink in the process. Check the
black ink type media list to select the correct type for the media you loaded.

1. Pressthe f home button.

2. Pressthe black ink change button.
3. Select Proceed and select one of these types of black ink to switch to:
» Photo Black to Matte Black; switching takes about 1.5 minutes
« Matte Black to Photo Black; switching takes about 3.5 minutes
Parent topic: Switch Black Ink Type

Related references
Black Ink Type Media List
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Adjusting Print Quality
If your print quality declines, you may need to run a utility to clean or align the print head.

If running these utilities does not solve the problem, you may need to replace the ink cartridges.

Print Head Maintenance
Print Head Alignment
Cleaning the Paper Guide

Print Head Maintenance

If your printouts become too light, or you see dark or light bands across them, you may need to clean the
print head nozzles. Cleaning uses ink, so clean the nozzles only if print quality declines.

You can check for clogged nozzles before you clean them so you don’t clean them unnecessarily.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Print Head Nozzle Check
Print Head Cleaning

Parent topic: Adjusting Print Quality
Related tasks
Removing and Installing Ink Cartridges

Print Head Nozzle Check

You can print a nozzle check pattern to check for clogged nozzles.

Checking the Nozzles Using the Product Control Panel
Checking the Nozzles Using a Computer Utility

Parent topic: Print Head Maintenance

Checking the Nozzles Using the Product Control Panel
You can check the print head nozzles using the control panel on your product.
1. Press the M home button, if necessary.

2. Press the il setup button.
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You see this screen:

I Setup

Maintenance

System Adminmistration

Network Status
Print Status Sheet

Select Maintenance.

Select Print Head Nozzle Check.

Load a few sheets of plain paper in the sheet feeder.

Select Print.

The nozzle pattern prints.

Check the printed pattern to see if there are gaps in the lines.
Print head is clean
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8. Do one of the following:
« Ifthere are no gaps, select Done.
« Ifthere are gaps or the pattern is faint, select Clean the Print Head and continue.

9. Follow the instructions on the screen to clean the print head, check the nozzles, and repeat the
process as necessary.

If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours. Then
try cleaning the print head again. If quality still does not improve, one of the ink cartridges may be old or
damaged and needs to be replaced.

Parent topic: Print Head Nozzle Check

Related tasks
Cleaning the Print Head Using the Product Control Panel
Removing and Installing Ink Cartridges

Checking the Nozzles Using a Computer Utility
You can check the print head nozzles using a utility on your Windows or Mac computer.
1. Load afew sheets of plain paper in the sheet feeder.
2. Do one of the following:
* Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.

* OS X: In the Apple menu or the Dock, select System Preferences. Select Print & Fax, Print &
Scan, or Printers & Scanners, select your product, and select Options & Supplies. Select
Utility and select Open Printer Utility.

3. Select Nozzle Check.
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You see a window like this:

MNozzle Check “

To perform a nozze chedk, make sure that the printer is on and
connected to the computer. Make sure that the CDJ/DVD tray is
removed and that the front manual fesd tray is dosed; otherwiss
"Mozzle Chedk” cannot be performed, Also make sure that A4 or Letber
size plan paper i loaded in suto sheet feeder, Clhids [Print] to print a
nozzie chedk pattern or didk [Cancel] to quit.

Cancel | Print I

Click Print.
Check the printed pattern to see if there are gaps in the lines.
Print head is clean
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6. Ifthere are no gaps, click Finish.
If there are gaps or the pattern is faint, clean the print head.

If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours. Then
try cleaning the print head again. If quality still does not improve, one of the ink cartridges may be old or
damaged and needs to be replaced.

Parent topic: Print Head Nozzle Check

Related tasks
Cleaning the Print Head Using the Product Control Panel
Cleaning the Print Head Using a Computer Utility

Print Head Cleaning

If print quality has declined and the nozzle check pattern indicates clogged nozzles, you can clean the
print head.

Note: You cannot clean the print head if an ink cartridge is expended, and may not be able to clean it
when a cartridge is low. You must replace the cartridge first.

Cleaning the Print Head Using the Product Control Panel
Cleaning the Print Head Using a Computer Utility

Parent topic: Print Head Maintenance

Related tasks
Removing and Installing Ink Cartridges

Cleaning the Print Head Using the Product Control Panel
You can clean the print head using the control panel on your product.
1. Press the M home button, if necessary.

2. Press the il setup button.
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You see this screen:

I Setup

Maintenance

System Adminmistration

Network Status
Print Status Sheet

Select Maintenance.

Select Print Head Cleaning.

Load a few sheets of plain paper in the sheet feeder.

Select Head Cleaning.

Select Print.

When the cleaning cycle is finished, you see a message on the screen.

Caution: Never turn off the product during a cleaning cycle or you may damage it.

Select Print Nozzle Check Pattern and select Print.
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9. Check the printed pattern to see if there are gaps in the lines.

Print head is clean

« Ifthere are no gaps, select Done.
« Ifthere are gaps or the pattern is faint, select Clean the Print Head and continue.

10. Follow the instructions on the screen to clean the print head, check the nozzles, and repeat the
process as necessatry.

If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours. Then
try cleaning the print head again. If quality still does not improve, one of the ink cartridges may be old or
damaged and needs to be replaced.

Parent topic: Print Head Cleaning

Related tasks

Removing and Installing Ink Cartridges

Cleaning the Print Head Using a Computer Utility
Checking the Nozzles Using the Product Control Panel

Cleaning the Print Head Using a Computer Utility
You can clean the print head using a utility on your Windows computer or Mac.
1. Load afew sheets of plain paper in the sheet feeder.
2. Do one of the following:
» Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.
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« Inthe Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and
select Open Printer Utility.

3. Select Head Cleaning.
You see a window like this:

Head Cleaning “

Miske sure that the CD/OVD tray is removed and that the front manual
feed tray is dosed; otherwise "Head Cleaning” cannot be performed.
Click [Start] to dean the print head nozzles. Because deaning
consUmes some ink, only dean the print head when fant areas or
GBS appear in your printout. Use the "Nozzle Chedk” utiity first to
confirm that the print head needs to be deaned. If the ink is low or
expended, replace the cartridge first.

Caubon: Do not open or cdose tray.

Start Cancel

4. Click Start to begin the cleaning cycle.

The O power light flashes throughout the cleaning cycle and stays on when the cleaning cycle is
finished.

Caution: Never turn off the product during a cleaning cycle or you may damage it.

5. When the cleaning cycle is finished, you can check to see if the nozzles are clean; click Print Nozzle
Check Pattern and click Print.
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6. Check the printed pattern to see if there are gaps in the lines.
Print head is clean

* If there are no gaps, click Finish.
« |fthere are gaps or the pattern is faint, click Clean to clean the print head again.

If you don’t see any improvement after cleaning the print head up to 4 times, wait at least 6 hours. Then
try cleaning the print head again. If quality still does not improve, one of the ink cartridges may be old or
damaged and needs to be replaced.

Parent topic: Print Head Cleaning

Related tasks
Removing and Installing Ink Cartridges

Print Head Alignment

If your printouts become grainy or blurry, you notice misalignment of vertical lines, or you see dark or
light horizontal bands, you may need to align the print head.

Note: Banding may also occur if your print head nozzles need cleaning.

Aligning the Print Head Using the Product Control Panel
Aligning the Print Head Using a Computer Utility

Parent topic: Adjusting Print Quality
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Aligning the Print Head Using the Product Control Panel
You can align the print head using the control panel on your product.
1. Press the M home button, if necessary.

2. Press the il setup button.
You see this screen:

I¥ Setup
Maintenance

System Administration

Network Status

Print Status Sheet

Select Maintenance.
Press the down arrow and select Head Alignment.
Load a few sheets of plain paper in the sheet feeder.

o gk~ w

Select Print to print an alignment sheet.
Note: Do not cancel printing while you are printing head alignment patterns.

After the alignment sheet is printed, you see a series of screens asking you to select the best square
in each pattern set.

7. Check the printed patterns and choose the number representing the best square for each set, then
select Proceed.

8. After you have selected the number for all the sets, select Done.
Parent topic: Print Head Alignment
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Aligning the Print Head Using a Computer Utility
You can align the print head using a utility on your Windows computer or Mac.
1. Load afew sheets of plain paper in the sheet feeder.
2. Do one of the following:
» Windows: Access the Windows Desktop and right-click the product icon in the Windows taskbar.

* Inthe Apple menu or the Dock, select System Preferences. Select Print & Fax, Print & Scan, or
Printers & Scanners, select your product, and select Options & Supplies. Select Utility and
select Open Printer Utility.

3. Select Print Head Alignment.
You see a window like this:

Print Head Alignment “

The Print Head Alignment utiity fixes vertical misalignmeant, horizontal
banding, and blurry printouts,

Make sure that the CD/OVD tray is removed and that the front manual

feed tray is dosed; otherwise Print Head Algnment” cannot be
performed.

Cancel Mext =

4. Click Next then click Print to print an alignment sheet.

Note: Do not cancel printing while you are printing a head alignment pattern.
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You see a window like this:

Print Head Alignment “

Look at the alignment sheet.

Find the square without any visible bands in sets #1 through #9. Salect
the number that comesponds to that square from the kst below for al
sets. Then chck [Finesh].

If every square containg a band, salect the sguare with the thinnest
band or bands. Then dick [Realignment].

21 |5 W 27 |5 b
# |3 ¥ #8 |3 b
#3 |5 ¥ ## |5 b
=4 |5 W
#5 |5 W
25 |5 W
Realgnment Cancel Firish

5. Check the printed pattern and follow the instructions on the screen to choose the number
representing the best printed pattern for each set.

» After choosing each pattern number, click Next.

* If no patterns are aligned in one or more of the sets, choose the closest one in each set and click
Realignment. Then print another alignment sheet and check it.

Note: Click Skip (where available) if you want to skip a particular alignment sheet.

6. When you are done, click Finish.
Parent topic: Print Head Alignment
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Cleaning the Paper Guide
If you see ink on the back of a printout, you can clean the paper guide rollers to remove any excess ink.
1. Load several sheets of plain paper (or a cleaning sheet) in the sheet feeder.
2. Press the M home button, if necessary.
3. Press the il setup button.
You see this screen:

1Y Setup

Maintenance

System Administration

Network Status
Print Status Sheet

4. Select Maintenance.
5. Select Paper Guide Cleaning.
6. SelectRoller Cleaning.
The paper feeds through your product.
7. Repeat these steps as necessary until no ink appears on the back of your printouts.
Parent topic: Adjusting Print Quality
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Cleaning and Transporting Your Product

See these sections if you need to clean or transport your product.

Cleaning Your Product
Transporting Your Product

Cleaning Your Product
To keep your product working at its best, you should clean it several times a year.

Caution: Do not use a hard brush, benzene, alcohol, or paint thinner to clean the product or you may
damage it. Do not place anything on top of the cover or use the cover as a writing surface, or it could get
permanently scratched. Do not use oil or other lubricants inside the product or let water get inside.

Turn off the product.

Unplug the power cable.

Disconnect any connected cables.

Remove all the paper and the roll paper holders from the product.

Clean the paper support and manual feed tray using a soft brush or a dry microfiber cloth.
Close the paper support, manual feed tray, output tray, and any covers.

Clean the outer case with a soft cloth dampened with a mild detergent.

Plug the power cable back in and turn on the product.

© © N A~ ®DdDPRE

Load several sheets of plain paper (or a cleaning sheet) in the sheet feeder and clean the paper
guide.

Close the rear paper support and output tray when you are not using the product to help keep it clean.
Parent topic: Cleaning and Transporting Your Product

Transporting Your Product

If you need to store your product or transport it a long distance, prepare it for transportation as described
here.

Caution: During transportation and storage, follow these guidelines:
» Avoid tilting the product, placing it vertically, or turning it upside down; otherwise ink may leak.
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» Leave the ink cartridges installed. Removing the cartridges can dry out the print head and may prevent
the product from printing.

Turn off the product.

Remove all the paper from the product.

Unplug the power cable.

Disconnect any connected cables.

Remove the roll paper holders.

Close the rear paper support and the output tray.

N o ok~ owDNPR

Open the printer cover.
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8. Secure the ink cartridge holder to the case with tape. Leave the ink cartridges installed to avoid
damaging the product.

Note: Some tape may be difficult to remove if left in place for a long time. Remove the tape
immediately after transporting the product.

9. Close the printer cover.
10. Open the front cover.
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11. Attach the transportation lock shown here to the lower right of the front manual feed tray and secure
it with tape.
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12. Attach the transportation lock shown here to the top of the front manual feed tray and secure it with
tape.

\ )
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13. Attach the transportation lock shown here to the bottom of the front manual feed tray and secure it
with tape.

14. Close the front cover and secure it with tape.
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15. Place the product in its original packing materials, if possible, or use equivalent materials with
cushioning around the product. Make sure the box adequately protects the product control panel.

16. After unpacking the product, be sure to remove all of the tape.

Keep the product level during transportation. If print quality has declined when you print again, clean and
align the print head.

Parent topic: Cleaning and Transporting Your Product

Related concepts
Print Head Cleaning
Print Head Alignment
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Solving Problems

Check these sections for solutions to problems you may have using your product.

Checking for Software Updates

Product Status Messages

Running a Product Check

Resetting Control Panel Defaults

Solving Setup Problems

Solving Network Problems

Solving Paper Problems

Solving Problems Printing from a Computer
Solving Page Layout and Content Problems
Solving Print Quality Problems

Solving CD/DVD Problems

Uninstall Your Product Software

Where to Get Help

Checking for Software Updates

Periodically, it's a good idea to check Epson's support website for free updates to your product software.
Visit the driver download site at (U.S. downloads or Canadian downloads).

* Windows: Your printer software automatically checks for updates. You can also manually update the
software by:

» Accessing the Windows Desktop, right-clicking the product icon in the Windows taskbar, then
clicking Software Update.

* Clicking on the Utility tab in the printer settings window and selecting Driver Update

You can also update the software by selecting EPSON Software Updater in the EPSON or EPSON
Software program group, accessible by the Start button, or on the Start or Apps screens, depending
on your version of Windows.

» OS X: You can manually update the software by opening the Applications > Epson Software folder
and selecting EPSON Software Updater.

Parent topic: Solving Problems
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Product Status Messages

You can often diagnose problems with your product by checking the messages on its LCD screen.

Note: If the LCD screen is dark, press the screen to wake the product from sleep mode.

LCD screen message

Condition/solution

Close the printer cover. See your
documentation for details.

Paper may be jammed in the product. If paper is jammed in the
product, follow the instructions in this guide to remove the
jammed paper from the indicated area.

Printer Error. Turn power off and
then on again. For details, see your
documentation.

A serious error has occurred. Turn the product off and then back
on again. If the error continues, check for a paper jam. If there is
no paper jam, contact Epson for support.

A printer's ink pad is nearing the end
of its service life. Please contact
Epson Support.

The ink pads are near the end of their service life and the
message will be displayed until the ink pad is replaced. Contact
Epson to replace ink pads before the end of their service life.

A printer's ink pad is at the end of its
service life. Please contact Epson
Support.

The ink pad is at the end of its service life. Turn off the product
and contact Epson for support.

Combination of IP address and
subnet mask is invalid. See your
documentation.

There is a problem with the network connection to your product.

Some functions may not be
available. For details, see your
documentation.

When Paper Setup Display is set to Off, the Error Notice
setting automatically defaults to Off and AirPrint is not available.
Set the Paper Setup Display setting to On to use AirPrint.

Note: The ink pads in the printer collect, distribute, and contain the ink that is not used on printed pages.
During the life of your product it may reach a condition where either satisfactory print quality cannot be
maintained or the ink pads have reached the end of their usable life. The Epson Status Monitor, your
LCD, or lights on the control panel will advise you when these parts need replacing. If this happens
during the standard warranty of the product, the exchange of the product or replacement of the pads is
covered under the standard warranty. If the product is out of warranty, the pads can be replaced by any
Epson authorized service provider. The waste ink pads are not a user-replaceable part.

Parent topic: Solving Problems
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Related references

Paper Jam Problems in the Sheet Feeder

Paper Jam Problems in the Front Manual Feed Tray
Paper Jam Problems - Thick Media

Paper Jam Problems - Roll Paper

CD/DVD Jam Problems

Where to Get Help

Related tasks
Checking for Software Updates

Related topics

Replacing Ink Cartridges
Wi-Fi or Wired Networking
Loading Media

Running a Product Check
Running a product check helps you determine if your product is operating properly.
1. Disconnect any interface cables connected to your product.
2. Make sure plain paper is loaded in the sheet feeder.
3. Press the M home button, if necessary.
4

Press the ' setup button.
You see this screen:

Iy Setup

Maintenance

System Adminmistration

Network Status
Print Status Sheet
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5. Select Maintenance.
Select Print Head Nozzle Check.
7. Select Print.
The nozzle pattern prints.
8. Do one of the following, depending on the results of the product check:

« |f the page prints and the nozzle check pattern is complete, the product is operating properly. Any
operation problem you may have could be caused by your computer, cable, software, or selected
settings. Check the other solutions in this manual or try uninstalling and reinstalling your printer
software.

« |f the page prints but the nozzle check pattern has gaps, clean or align the print head.

* If the page does not print, the product may have a problem. Check the other solutions in this
manual. If they do not work, contact Epson.

Parent topic: Solving Problems

Related concepts

Print Head Cleaning

Print Head Alignment

Uninstall Your Product Software

Related references
Where to Get Help

Resetting Control Panel Defaults

If you have a problem with settings on the product control panel, you can reset them to their factory
defaults. You can choose which settings to reset or reset them all.

Note: This setting can be locked by an administrator. If you cannot access or change this setting,
contact your administrator for assistance.

1. Press the M home button, if necessary.
2. Press the il setup button.
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You see this screen:

I Setup

Maintenance

System Adminmistration

Network Status
Print Status Sheet

3. Select System Administration.
4. Press the down arrow button and select Restore Default Settings.
5. Select one of these options:
» Network Settings: Resets all network settings.
« All except Network Settings: Resets all except network settings.
« All Settings: Resets all control panel settings.
You see a confirmation screen.
6. Select Yes to reset the selected settings. (Select No if you want to cancel the operation.)
Parent topic: Solving Problems

Solving Setup Problems
Check these sections if you have problems while setting up your product.

Noise After Ink Installation
Software Installation Problems

Parent topic: Solving Problems
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Noise After Ink Installation
If you hear noises from your product after installing ink, check the following:

The first time you install ink cartridges, the product must prime its print head. Wait until priming
finishes before you turn off the product, or it may prime improperly and use excess ink the next time
you turn it on. Your product is finished priming the print head when the O power light stops flashing.

If the product's print head stops moving or making noise, and the charging process has not finished
after approximately 5 minutes, turn off your product. Turn it back on and check to see if charging is still
in progress. If it is still in progress, contact Epson for help.

Turn off the product, then make sure the ink cartridges are inserted completely and the ink cartridge
cover is closed completely. Also make sure no packing material remains in the product. Wait a
moment, then turn the product back on to clear the error.

Parent topic: Solving Setup Problems

Software Installation Problems
If you have problems while installing your product software, try these solutions:

Make sure your product is turned on and any necessary cables are securely connected at both ends. If
you still have problems installing software, disconnect the cable and carefully follow the instructions on
the Start Here sheet. Also make sure your system meets the requirements for your operating system.

Close any other programs, including screen savers and virus protection software, and install your
product software again.

In Windows, make sure your product is selected as the default printer and the correct port is shown in
the printer properties.

If you see any error message or your software does not install correctly in Windows, you may not have
software installation privileges. Contact your System Administrator.

If you are printing over a network, make sure your product is set up properly on the network.

Parent topic: Solving Setup Problems

Related concepts
Uninstall Your Product Software

Related references
Windows System Requirements
OS X System Requirements
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Solving Network Problems
Check these solutions if you have problems setting up or using your product on a network.

Note: Breakdown or repair of this product may cause loss of network data and settings. Epson is not
responsible for backing up or recovering data and settings during or after the warranty period. We
recommend that you make your own backup or print out your network data and settings.

Product Cannot Connect to a Wireless Router or Access Point
Network Software Cannot Find Product on a Network

Product Does Not Appear in OS X Printer Window

Cannot Print Over a Network

Parent topic: Solving Problems

Product Cannot Connect to a Wireless Router or Access Point
If your product has trouble finding or connecting to a wireless router or access point, try these solutions:

If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon on your
product's LCD screen is not lit or does not appear, make sure you select one of the WPS options from
the product control panel within 2 minutes of pressing the WPS button on your router.

Make sure to place your product within contact range of your 2.4 GHz router or access point. Avoid
placing your product near a microwave oven, 2.4 GHz cordless phone, or large metal object, such as a
filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5
GHz) mode. See your router documentation for instructions.

Verify that your router or access point is operating correctly by connecting to it from your computer or
another device.

You may need to disable the firewall and any anti-virus software on your wireless router or access
point.

Check to see if access restrictions, such as MAC address filtering, are set on the router or access
point. If access restrictions are set, add your product's MAC address to your router's address list. To
obtain your product's MAC address, print a network status sheet. Then follow the instructions in your
router or access point documentation to add the address to the list.

If your router or access point does not broadcast its network name (SSID), follow the instructions that
came with your product to enter your wireless network name manually.
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« If your router or access point has security enabled, determine the kind of security it is using and any
required password or passphrase for connection. Then make sure to enter the exact WEP key or WPA
passphrase correctly.

» Check if your computer is restricting the available wireless channels. If so, verify that your wireless
access point is using one of the usable channels and change to a usable channel, if necessary.

« If you are using a Wi-Fi Direct connection that suddenly disconnects, the Wi-Fi direct password on
your device may have been changed. If necessary, delete the existing DIRECT-XXXXXXXX connection
settings from your device and enter a new password. See your device documentation for instructions.

« |If you connected your product to a Windows computer using Wi-Fi Direct and it automatically selected
Access Point Mode, you may have trouble accessing a low-priority Internet connection. Check the
network connection or adapter settings in the Windows Control Panel and set the Internet metric
setting to 100 for your version of the Internet Protocol.

Parent topic: Solving Network Problems

Related concepts
Wi-Fi Direct Mode Setup

Related tasks
Printing a Network Status Sheet
Selecting Wireless Network Settings from the Control Panel

Related topics
Wi-Fi or Wired Networking

Network Software Cannot Find Product on a Network
If EpsonNet Setup cannot find your product on a network, try these solutions:

» Make sure your product is turned on and connected to your network. Verify connection using your
product control panel.

» Check if your network name (SSID) contains non-ASCII characters. Your product cannot display non-
ASCII characters.

» Make sure your product is not connected to a guest network.

 If necessary, reinstall your product software and try running EpsonNet Setup again:
1. Reset your product's network settings to their factory defaults.
2. Windows only: uninstall your product software.
3. Initialize your router following the instructions in your router documentation.
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Note: If you are reading these instructions online, you will lose your Internet connection when you
initialize your router, so note the next step before initializing it.

4. Download your product software from the Epson website using the instructions on the Start Here
sheet.

* If you have replaced your router, reinstall your product software to connect to the new router.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5
GHz) mode. See your router documentation for instructions.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Related topics
Wi-Fi or Wired Networking

Product Does Not Appear in OS X Printer Window
If your product does not appear in the OS X printer window, try these solutions:
» Turn your product off, wait 30 seconds, then turn it back on again.

* If you are connecting the product wirelessly via EpsonNet Setup and a WiFi symbol is not displayed on
the product's LCD screen, make sure your product software was installed correctly. If necessary,
reinstall your software.

» Make sure you installed your product software correctly for your network. See the Start Here sheet for
instructions.

« If your Mac includes both wired and wireless network services, make sure the network to which you

connected your product is at the top of the Set Service Order list. Check your Mac documentation for
instructions.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5
GHz) mode. See your router documentation for instructions.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software
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Cannot Print Over a Network
If you cannot print over a network, try these solutions:

Make sure that your product is turned on.
Make sure you install your product's network software as described in your product documentation.

Print a network status sheet and verify that the network settings are correct. If the network status is
Disconnected, check any cable connections and turn your product off and then on again.

If you are using TCP/IP, make sure the product's IP address is set correctly for your network. If your
network does not assign IP addresses using DHCP, set the IP address manually.

Make sure your computer and product are both using the same wireless network.

If network printing is slow, print a network status sheet and check the signal strength. If it is poor, place
your product closer to your router or access point. Avoid placing your product near a microwave oven,
2.4 GHz cordless phone, or large metal object, such as a filing cabinet.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5
GHz) mode. See your router documentation for instructions.

Check to see if your wireless router or access point has an enabled Privacy Separator function that is
preventing printing from a device over the network. See your router or access point documentation for
instructions on disabling the Privacy Separator function.

If you are connecting the product via Wi-Fi Protected Setup (WPS) and the Wi-Fi icon does not appear
on your product's LCD screen, make sure you select one of the WPS options from the product control
panel within 2 minutes of pressing the WPS button on your router.

Check your wired LAN router or access point to see if the LED for the port to which your product is
connected is on or flashing. If the link LED is off, try the following:

» Make sure the Ethernet cable is securely connected to your product and to your router, access
point, switch, or hub.

» Try connecting your product to a different port or a different router, access point, switch, or hub.
» Try connecting with a different Ethernet cable.
» Try printing to your product from another computer on the network.

Note: If you are using a 5 GHz wireless router, set the router to operate in dual band (2.4 GHz and 5
GHz) mode. See your router documentation for instructions.
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« If you are connecting the product via EpsonNet Setup and the Wi-Fi icon does not appear on the LCD,
make sure your product software was installed correctly. If necessary, reinstall your software.

Parent topic: Solving Network Problems

Related concepts
Uninstall Your Product Software

Related tasks
Printing a Network Status Sheet

Related topics
Wi-Fi or Wired Networking

Solving Paper Problems

Check these sections if you have problems using paper with your product.
Paper Feeding Problems

Paper Jam Problems in the Sheet Feeder

Paper Jam Problems in the Front Manual Feed Tray

Paper Jam Problems - Thick Media

Paper Jam Problems - Roll Paper

Paper Ejection Problems

Parent topic: Solving Problems

Paper Feeding Problems
If you have problems feeding paper, try these solutions:

« If paper does not feed into the sheet feeder, remove the paper and fan the edges to separate the
sheets. Reload paper against the right side and slide the edge guide against it. Do not load too many
sheets in the sheet feeder at once and make sure the product cover is closed.

* When using the sheet feeder, do not load paper above the arrow mark on the left edge guide. Load
only one sheet of compatible paper when using the front manual feed tray.

* Load only one sheet of media in the front manual feed tray in this size: 13 x 19 inches
(330 x 483 mm). For poster board, make sure there is enough space behind the product for the media
to feed through.

 If multiple pages feed at once, remove the paper, fan the edges to separate the sheets, and reload it.
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If you can not insert paper easily into the front manual feed tray, make sure the paper is perfectly flat
and not curled.

If you are printing on roll paper or with the sheet feeder, make sure the manual feed tray is not
extended. Extend it only to load fine art paper or poster board. Once the media is fed into the product
and you see a message on the LCD screen, close the manual feed tray.

If paper loaded using the front manual feed tray does not feed, make sure you installed the paper
correctly and guided it all the way into the product.

Do not load more than the recommended number of sheets.
Make sure paper is loaded in the correct orientation. Load cut sheets in the sheet feeder vertically.
Make sure your paper meets the specifications for your product.

If paper dust builds up on the rollers, they may lose traction and become unable to feed paper
properly. Clean the paper guide.

If roll paper does not feed, cut the end straight across and uncurl it by rolling it backward, if necessary.
Then reload the paper.

If thick media does not feed, make sure you are loading it straight into the product, not at an angle.
Make sure the transportation lock is removed from the front manual feed tray.

If paper jams when you print on both sides of the paper, try loading fewer sheets.

For best results, follow these guidelines:

» Use new, smooth, high-quality paper that is not damp, curled, creased, old, too thin, or too thick.
» Load paper printable side up.

» Follow any special loading instructions that came with the paper.

Parent topic: Solving Paper Problems

Related references
Paper Jam Problems in the Sheet Feeder

Paper Jam Problems in the Front Manual Feed Tray
Paper Jam Problems - Thick Media

Paper Jam Problems - Roll Paper

Paper Ejection Problems

Cut Sheet Media Loading Capacity
Paper Specifications
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Related topics
Loading Media

Paper Jam Problems in the Sheet Feeder
If paper has jammed in the sheet feeder, try this solution:
1. Carefully remove any paper jammed in the sheet feeder or the front output area.

3. Close the printer cover and select Restart.
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4. If an error is still displayed, turn off the product, then turn it back on.
5. If you are unable to remove the paper, contact Epson for support.
Parent topic: Solving Paper Problems

Related references

Paper Jam Problems in the Front Manual Feed Tray

Paper Jam Problems - Thick Media
Paper Jam Problems - Roll Paper

Paper Jam Problems in the Front Manual Feed Tray
If paper has jammed in the front manual feed tray, try these solutions:
1. Cancel the print job from your computer, if necessary.
2. Carefully remove the jammed paper from the front or back as shown (whichever is easier).
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3. Open the printer cover and slowly pull any jammed paper out of the product.

4. Close the printer cover and select Restart.

5. If an error is still displayed, turn off the product, then turn it back on.
6. If you are unable to remove the paper, contact Epson for support.
Parent topic: Solving Paper Problems

Related references

Paper Jam Problems in the Sheet Feeder
Paper Jam Problems - Thick Media
Paper Jam Problems - Roll Paper

Paper Jam Problems - Thick Media

If poster board or other thick media has jammed inside the product, try these solutions:
1. Cancel the print job from your computer, if necessary.
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2. Carefully remove the jammed paper from the front or back as shown (whichever is easier).

4. Close the printer cover and select Restart.

5. If an error is still displayed, turn off the product, then turn it back on.
6. If you are unable to remove the paper, contact Epson for support.
Parent topic: Solving Paper Problems

Related references

Paper Jam Problems in the Sheet Feeder

Paper Jam Problems in the Front Manual Feed Tray
Paper Jam Problems - Roll Paper
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Paper Jam Problems - Roll Paper
If roll paper has jammed inside the product, try these solutions:
1. Cancel the print job from your computer, if necessary.

2. Cut the paper close to the roll paper feeder and the output tray as shown.
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4. Open the printer cover and slowly pull any jammed paper out of the product.

5. Close the printer cover and select Restart.

6. If an error is still displayed, turn off the product, then turn it back on.
7. If you are unable to remove the paper, contact Epson for support.
Parent topic: Solving Paper Problems

Related references

Paper Jam Problems - Thick Media

Paper Jam Problems in the Sheet Feeder

Paper Jam Problems in the Front Manual Feed Tray

Paper Ejection Problems
If you have problems with paper ejecting properly, try these solutions:

« |f paper does not eject fully, you may have set the wrong paper size. Cancel printing using the product
control panel, then select Eject or Cut/Eject (roll paper) to eject the paper. Remove any paper
remaining in the product. Select the correct size when you reprint.

« If paper is wrinkled when it ejects, it may be damp or too thin. Load new paper and be sure to select
the correct paper type setting in your printer software when you reprint.

Parent topic: Solving Paper Problems
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Related references

Paper Jam Problems in the Sheet Feeder

Paper Jam Problems in the Front Manual Feed Tray
Paper Jam Problems - Thick Media

Paper Jam Problems - Roll Paper

Related tasks
Selecting the Paper Settings for Each Source - Control Panel
Selecting the Default Paper Setup Display and Error Notice Settings

Related topics
Loading Media

Solving Problems Printing from a Computer
Check these sections if you have problems while printing from your computer.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Nothing Prints

Product Icon Does Not Appear in Windows Taskbar
Error After Cartridge Replacement

Printing is Slow

Parent topic: Solving Problems

Nothing Prints
If you have sent a print job and nothing prints, try these solutions:
» Make sure your product is turned on.
» Make sure any interface cables are connected securely at both ends.
» Make sure the interface specifications match the specifications for the printer and the computer.

« If you connected your product to a USB hub, make sure it is a first-tier hub. If it still does not print,
connect your product directly to your computer instead of the hub.

* Run a product check to see if a test page prints. If the test page prints, check to see if your product
software is installed correctly.

* In Windows, make sure your product is selected as the default printer.
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* In Windows, make sure the printer port setting matches the printer connection port.
* In Windows, clear any stalled print jobs from the Windows Spooler:

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers. Right-click your product name, select See what's printing, and select your
product name again if necessary. Right-click the stalled print job, click Cancel, and click Yes.

* Windows 7: ClickﬂII and select Devices and Printers. Right-click your product name, select See
what's printing, and select your product name again, if necessary. Right-click the stalled print job,
click Cancel, and click Yes.

* In OS X, make sure the printer is added to the printer list.
Parent topic: Solving Problems Printing from a Computer

Related tasks
Running a Product Check

Product Icon Does Not Appear in Windows Taskbar

If you do not see your product icon in the Windows taskbar, first try restarting your computer. If that does
not work, try this solution:

1. Do one of the following:

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Hardware and Sound >
Devices and Printers.

 Windows 7: CIickE]' and select Devices and Printers.

n

Right-click your product name, select Printing Preferences, and select your product name again if
necessary.

Click the Utility tab.
Click the Monitoring Preferences button.
Click the checkbox for the option that adds the shortcut icon to the taskbar.

o g bk~ w

Click OK to close the open program windows.
Parent topic: Solving Problems Printing from a Computer

Error After Cartridge Replacement
If you see an error message after you replace an ink cartridge, follow these steps:
1. Remove and reinsert the replaced ink cartridge, making sure to push it all the way into its slot.
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2. Complete the ink cartridge installation steps.

Parent topic: Solving Problems Printing from a Computer

Printing is Slow
If printing becomes slow, try these solutions:

Make sure your system meets the requirements for your operating system. If you are printing a high-
resolution image, you may need more than the minimum requirements. If necessary, increase your
system's memory.

If you are using Windows 7, close the Devices and Printers window before you print.

If you are using OS X, make sure you download and install the Epson printer driver.
Clear space on your hard drive or run a defragmentation utility to free up existing space.
Close any programs you are not using when you print.

If your product is connected to a USB hub, connect it directly to your computer instead.

If printing becomes slower after printing continuously for a long time, the product may have
automatically slowed down to protect the print mechanism from overheating or becoming damaged.
Let the product rest with the power on for 30 minutes, then try printing again.

For the fastest printing, select the following settings in your product software:

Make sure the paper type setting matches the type of paper you loaded.
Turn on any high speed settings in your product software.
Select a lower print quality setting.

Windows: Click the Maintenance or Utility tab, select Extended Settings or Speed and Progress,
and select the following settings:

» High Speed Copies

* Always Spool RAW Datatype
» Page Rendering Mode

e Print as Bitmap

Parent topic: Solving Problems Printing from a Computer

Related references

Paper or Media Type Settings - Control Panel
Paper or Media Type Settings - Product Software
Windows System Requirements
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OS X System Requirements

Related tasks

Selecting Basic Print Settings - Windows
Selecting Additional Settings - Windows
Selecting Basic Print Settings - OS X

Solving Page Layout and Content Problems
Check these sections if you have problems with the layout or content of your printed pages.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

Inverted Image

Too Many Copies Print

Blank Pages Print

Incorrect Margins on Printout

Border Appears on Borderless Prints
Incorrect Characters Print

Incorrect Image Size or Position
Slanted Printout

Parent topic: Solving Problems

Inverted Image
If your printed image is inverted unexpectedly, try these solutions:
» Turn off any mirror or inversion settings in your printing application.

» Turn off the Mirror Image, Flip horizontally, or Reverse page orientation settings in your printer
software. (This option has different names, depending on your operating system version.)

Note: Leave these options turned on when you print on Epson Iron-on Cool Peel Transfer paper, if
available for your product.

Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Print Layout Options - Windows
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Selecting Additional Settings - Windows
Selecting Basic Print Settings - OS X

Too Many Copies Print

Make sure that the Copies setting in your printing program or printer software is not set for multiple
copies.

Parent topic: Solving Page Layout and Content Problems

Related tasks

Selecting Print Layout Options - Windows
Selecting Additional Settings - Windows
Selecting Basic Print Settings - OS X

Blank Pages Print
If blank pages print unexpectedly, try these solutions:
» Make sure you selected the correct paper size settings in your printing program and printer software.

« If a blank page exists in a document you are printing and you want to skip printing it, select the Skip
Blank Page setting in your printer software, if available.

* Run a print head nozzle check to see if any of the nozzles are clogged. Then clean the print head, if
necessary.

» Make sure your product is selected as the printer in your printing program.
Parent topic: Solving Page Layout and Content Problems
Related concepts

Print Head Nozzle Check
Print Head Cleaning

Related tasks

Selecting Basic Print Settings - Windows
Selecting Additional Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Printing Preferences - OS X
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Incorrect Margins on Printout
If your printed page has incorrect margins, try these solutions:
» Make sure you selected the correct paper size settings in your printing program and printer software.
* Make sure you selected the correct margins for your paper size in your printing program.
» Make sure your paper is positioned correctly for feeding into the printer.
You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X

Related topics
Loading Media

Border Appears on Borderless Prints
If you see a border on borderless prints, try these solutions:
» Make sure you are printing on a compatible borderless paper type and size.

Note: Do not select a custom paper size for borderless prints.

* Windows: Make sure you selected the Borderless setting in your printer software.

» OS X: Make sure you selected the Borderless checkbox or a paper size with a Borderless option in
your printer software.

» Adjust the Expansion setting to adjust the amount of image expansion on the edges of borderless
prints.

» Make sure the image size and the paper size are set correctly; if the image is small, the enlargement
may not be enough to cover the paper.

Parent topic: Solving Page Layout and Content Problems

Incorrect Characters Print
If incorrect characters appear in your prints, try these solutions before reprinting:
» Make sure any cables are securely connected at both ends.
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* In Windows, delete all jobs from the Windows Spooler. Click Print Queue on the Utility tab in the
printer settings window, and cancel any stalled print jobs.

« If your product is connected to a USB hub, connect it directly to your computer instead.
« Ifincorrect characters still appear in your prints, try connecting your product using a different cable.
Parent topic: Solving Page Layout and Content Problems

Incorrect Image Size or Position
If your printed image is the wrong size or in the wrong position, try these solutions:

» Make sure you selected the correct paper size and layout settings in your printing program and printer
software.

» Make sure you selected the correct paper size on the control panel.

» Make sure your paper is positioned correctly for feeding into the printer.

You can use the preview option in your printer software to check your margins before you print.
Parent topic: Solving Page Layout and Content Problems

Related tasks

Selecting Basic Print Settings - Windows
Selecting Additional Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Printing Preferences - OS X

Slanted Printout
If your printouts are slanted, try these solutions:
 Slide the edge guide against the edge of the paper.
» Select a higher print quality setting in your printer software.
» Turn off any high speed settings in your product software.
 Align the print head.
» Make sure the product is not printing while tilted or at an angle.
Parent topic: Solving Page Layout and Content Problems

Related tasks
Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X
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Related topics
Loading Media

Solving Print Quality Problems

Check these sections if your printouts have problems with print quality, but your image looks fine on your
computer screen.

Note: When printing using AirPrint, the available print settings are different from those covered in this
manual. See the Apple website for details.

White or Dark Lines in Printout
Blurry or Smeared Printout

Faint Printout or Printout Has Gaps
Grainy Printout

Incorrect Colors

Parent topic: Solving Problems

White or Dark Lines in Printout
If you notice white or dark lines in your prints (also called banding), try these solutions before you reprint:

Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

Make sure the paper type setting matches the type of paper you loaded.

Make sure you loaded the printable side of the paper correctly for your product.
Turn off any high speed settings in your product software.

Align the print head.

You may need to replace the ink cartridges.

Parent topic: Solving Print Quality Problems

Related concepts

Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment
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Related references
Paper or Media Type Settings - Control Panel

Related tasks

Selecting Print Layout Options - Windows
Selecting Additional Settings - Windows
Selecting Basic Print Settings - OS X

Related topics
Loading Media
Replacing Ink Cartridges

Blurry or Smeared Printout
If your printouts are blurry or smeared, try these solutions:

Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.

Use a support sheet with special paper, or load special paper one sheet at a time.

Make sure your paper meets the specifications for your product.

Use Epson papers to ensure proper saturation and absorption of genuine Epson inks.

Make sure the paper type setting in your product software matches the type of paper you loaded.
Make sure you loaded the printable side of the paper correctly for your product.

If you are printing on thick paper or poster board, make sure you select the appropriate settings.
Remove each sheet from the output tray as it is printed.

Avoid handling printouts on glossy paper right after printing to allow the ink to set.

Turn off any high speed settings in your product software.

If you print on both sides of a sheet of paper, smudges may appear on the reverse side of heavily
saturated or dark images. If one side of a sheet will contain a lighter image or text, print that side first.

Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

Align the print head.
Clean the paper path.

Note: Your product will not operate properly while tilted at an angle. Place it on a flat, stable surface that
extends beyond the base of the product in all directions.
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Parent topic: Solving Print Quality Problems

Related concepts
Print Head Cleaning
Print Head Alignment

Related references

Available Epson Papers

Paper Specifications

Double-sided Printing Options - Windows

Related tasks

Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Print Layout Options - Windows
Selecting Additional Settings - Windows
Selecting Printing Preferences - OS X
Cleaning the Paper Guide

Related topics
Loading Media

Faint Printout or Printout Has Gaps
If your printouts are faint or have gaps, try these solutions:

* Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

* The ink cartridges may be old or low on ink, and you may need to replace them.

» Make sure the paper type setting matches the type of paper you loaded.

» Make sure your paper is not damp, curled, old, or loaded incorrectly in your product.
 Align the print head.

* Clean the paper path.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning
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Print Head Alignment

Related references
Paper or Media Type Settings - Control Panel

Related tasks

Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X
Cleaning the Paper Guide

Related topics
Loading Media
Replacing Ink Cartridges

Grainy Printout
If your printouts are grainy, try these solutions:

Make sure you loaded the printable side of the paper correctly for your product.
Select a higher print quality setting and turn off any high speed settings in your product software.

Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

Align the print head.

You may need to increase the image resolution or print a smaller size; see your software
documentation.

Note: Images from the Internet may be low resolution and not result in a high quality printout.

If you enlarged the image in an image-editing program, you need to increase the resolution setting to
retain a high image quality. Increase the resolution by the same amount you increased the image size.
For example, if the resolution is 300 dpi (dots per inch) and you will double the image size later,
change the resolution setting to 600 dpi.

Note: Higher resolution settings result in larger file sizes, which take longer to process and print.
Consider the limitations of your computer system when selecting a resolution, and select the lowest
possible resolution that produces acceptable quality to keep file sizes manageable.

Parent topic: Solving Print Quality Problems
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Related concepts

Print Head Nozzle Check
Print Head Cleaning
Print Head Alignment

Related tasks

Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Print Layout Options - Windows
Selecting Additional Settings - Windows

Related topics
Loading Media

Incorrect Colors
If your printouts have incorrect colors, try these solutions:

Make sure the Advanced B&W Photo, Black/Grayscale or Grayscale setting is not selected in your
printer software.

Run a nozzle check to see if any of the print head nozzles are clogged. Then clean the print head, if
necessary.

The ink cartridges may be old or low on ink, and you may need to replace them.

Your printed colors can never exactly match your on-screen colors. However, you can use a color
management system to get as close as possible. Try using the color management options in your
printer software.

Try turning off the PhotoEnhance setting in Windows.
Try adjusting the Gamma setting.
For best results, use genuine Epson ink and paper.

Parent topic: Solving Print Quality Problems

Related concepts
Print Head Nozzle Check
Print Head Cleaning

Related references
Available Epson Papers
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Related tasks

Selecting Basic Print Settings - Windows
Selecting Basic Print Settings - OS X
Selecting Print Layout Options - Windows
Selecting Additional Settings - Windows
Managing Color - OS X

Solving CD/DVD Problems

Check these sections if you have problems printing on a CD/DVD with your product.

CD/DVD Jam Problems

Image Not Centered on CD/DVD

Image Does Not Cover Printable Area of Disc
Ink Smears on CD/DVD

Faint Image on CD/DVD

Parent topic: Solving Problems

CD/DVD Jam Problems
If a CD/DVD has jammed in the product, follow these steps to remove the CD/DVD tray:
1. Cancel the print job from your computer, if necessary.
2. Slowly pull the CD/DVD tray out of the product.

3. Select Restart.
4. If an error is still displayed, turn off the product, then turn it back on.
5. If you are unable to remove the CD/DVD tray, contact Epson for support.
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Parent topic: Solving CD/DVD Problems

Image Not Centered on CD/DVD

If your printed image is not centered on the disc, adjust the print position using the Epson Print CD
software. See the Epson Print CD help utility for details.

Parent topic: Solving CD/DVD Problems

Image Does Not Cover Printable Area of Disc

If you are using discs where the printable area extends to within 0.16 inch (4 mm) of the edge of the
center hole, you may need to adjust the Inner/Outer Diameter Setting in the Epson Print CD software.
See the Epson Print CD help utility for details.

Parent topic: Solving CD/DVD Problems

Ink Smears on CD/DVD
If you notice smeared ink on your disc, try these solutions:
» Make sure you are printing on ink jet-printable CDs or DVDs and that the surface of the disc is dry.
» Handle printed discs carefully and let them dry for 24 hours before inserting them in a drive.

» Adjust the print quality using the Epson Print CD software. See the Epson Print CD help utility for
details.

Parent topic: Solving CD/DVD Problems

Faint Image on CD/DVD

If your printed image is faint, adjust the print quality using the Epson Print CD software. See the Epson
Print CD help utility for details.

Parent topic: Solving CD/DVD Problems

Uninstall Your Product Software

If you have a problem that requires you to uninstall and re-install your software, follow the instructions for
your operating system.

Uninstalling Printing Software - Windows
Uninstalling Product Software - OS X

Parent topic: Solving Problems
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Uninstalling Printing Software - Windows

You can uninstall and then re-install your printer software to solve certain problems.

1. Turn off the product.

2. Disconnect any interface cables.

3. Do one of the following:

* Windows 8.x: Navigate to the Apps screen and select Control Panel > Programs > Programs

and Features. Select the uninstall option for your Epson product, then select Uninstall/Change.
Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product, if necessary, and click OK. Then follow any on-screen
instructions.

* Windows (other versions): CIickE]' or Start, and select All Programs or Programs. Select
Epson, select your product, then click EPSON Printer Software Uninstall.

Note: If you see a User Account Control window, click Yes or Continue.

In the next window, select your product, if necessary, and click OK. Then follow any on-screen
instructions.

4. Restart your computer, then re-install your software.
Note: If you find that re-installing your product software does not solve a problem, contact Epson.
Parent topic: Uninstall Your Product Software

Uninstalling Product Software - OS X

In most cases, you do not need to uninstall your product software before re-installing it. However, you
can download the Uninstaller utility from the Epson support website to uninstall your product software as
described here.

Note: If you find that re-installing your product software does not solve a problem, contact Epson.

1. To download the Uninstaller utility, visit the Epson download site (U.S. downloads or Canadian
downloads).
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Follow the instructions on the screen to install the Uninstaller utility.

Quit all applications currently running on your Mac.

Double-click the Uninstaller icon.

Select the checkbox for each software program you want to uninstall.

Click Uninstall.

Follow the on-screen instructions to uninstall the software.

To reinstall your product software, see the Start Here sheet for instructions.

Note: If you uninstall the printer driver and your product name remains in the Print & Fax, Print & Scan,
or Printers & Scanners window, select your product name and click the — (remove) icon to remove it.

Parent topic: Uninstall Your Product Software

Where to Get Help

If you need to contact Epson for technical support services, use the following support options.

Internet Support

Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for solutions to
common problems. You can download drivers and documentation, get FAQs and troubleshooting
advice, or e-mail Epson with your questions.

Speak to a Support Representative

Before you call Epson for support, please have the following information ready:

Product name

Product serial number (located on a label on the product)

Proof of purchase (such as a store receipt) and date of purchase
Computer configuration

Description of the problem

Then call:

U.S.: (5662) 276-7272, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM, Pacific
Time, Saturday
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» Canada: (905) 709-2567, 6 AM to 8 PM, Pacific Time, Monday through Friday, and 7 AM to 4 PM,
Pacific Time, Saturday

Days and hours of support are subject to change without notice. Toll or long distance charges may
apply.
Purchase Supplies and Accessories

You can purchase genuine Epson ink and paper at Epson Supplies Central at epson.com/ink3 (U.S.
sales) or epson.ca (Canadian sales). You can also purchase supplies from an Epson authorized reseller.
To find the nearest one, call 800-GO-EPSON (800-463-7766).

Parent topic: Solving Problems
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Technical Specifications

These sections list the technical specifications for your product.

Note: Epson offers a recycling program for end of life products. Please go to this site for information on
how to return your products for proper disposal.

Windows System Requirements
OS X System Requirements
Paper Specifications

Printable Area Specifications
Ink Cartridge Specifications
Dimension Specifications
Electrical Specifications
Environmental Specifications
Interface Specifications
Network Interface Specifications
Safety and Approvals Specifications

Windows System Requirements

To use your product and its software, your computer should use one of these Microsoft operating
systems:

* Windows 8.x
e Windows 7
* Windows Vista

Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications
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OS X System Requirements
To use your product and its software, your Mac should use one of these operating systems:
* 0OS X 10.9.x
* 0OSX10.8.x
+ OSX10.7.x

Note: Visit Epson's support website at epson.com/support (U.S.) or epson.ca/support (Canada) for the
latest in compatibility and drivers for your product.

Parent topic: Technical Specifications
Paper Specifications

Note: Since the quality of any particular brand or type of paper may be changed by the manufacturer at
any time, Epson cannot guarantee the quality of any hon-Epson brand or type of paper. Always test a
sample of paper stock before purchasing large quantities or printing large jobs.

Cut sheets - plain paper

Capacity Stack up to 0.47 inch (12 mm) thick on these paper sizes:
A4 (8.3 x 11.7 inches [210 x 297 mm])
B5 (7.2 x 10.1 inches [182 x 257 mm])
A5 (5.8 x 8.2 inches [148 x 210 mm])
A6 (4.1 x 5.8 inches [105 x 148 mm])
Letter (8.5 x 11 inches [216 x 279 mm])
Stack up to 0.20 inch (5 mm) thick on these paper sizes:
A3 (11.7 x 16.5 inches [297 x 420 mm])
B4 (13.9 x 9.84 inches [353 x 250 mm)])
Legal (8.5 x 14 inches [216 x 356 mm])

Non-standard sizes between 3.5 inches (89 mm) and 13 inches
(329 mm) wide, and between 5 inches (127 mm) and 44 inches
(1117.6 mm) long
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Thickness
Weight

Cut sheets - thick paper

Size

Capacity
Thickness

Roll paper
Size

Thickness
Weight

0.003 to 0.004 inch (0.08 to 0.11 mm)
17 Ib (64 g/m?) to 20 Ib (90 g/m?)

A4 (8.3 x 11.7 inches [210 x 297 mm])

A3 (11.7 x 16.5 inches [297 x 420 mm])

13 x 19 inches (330 x 483 mm)

Letter (8.5 x 11 inches [216 x 279 mm])

11 x 17 inches (279 x 432 mm)

1 sheet

Fine art media: 0.012 inch (0.3 mm) to 0.023 inch (0.7 mm)
Poster board: 0.023 inch (0.7 mm) to 0.051 inch (1.3 mm)

Roll paper width: 13 inches (329 mm)
0.003 to 0.004 inch (0.08 to 0.11 mm)
17 Ib (64 g/m?) to 20 Ib (90 g/m?)

Parent topic: Technical Specifications

Printable Area Specifications

Note: When printing borderless, quality may decline in the expanded printable area.
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Cut sheets - normal printing

:F:

1=

1  Topand side margins: 0.12 inch (3 mm) minimum
2  Top/quality border: 1.30 inches (33 mm) minimum
3  Bottom/quality border: 1.42 inches (36 mm) minimum

Note: Poster board margins are 0.79 inch (20 mm) for sizes smaller than 13 x 19 inches
(330 x 483 mm).
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Cut sheets - borderless printing

J_

Side/quality border: 0.12 inch (3 mm) minimum
Top/quality border: 1.42 inches (36 mm) minimum
Bottom/quality border: 1.54 inches (39 mm) minimum

Note: You cannot print borderless on poster board.

197



Roll paper - normal printing

1  Side margins: 0.12 inch (3 mm) minimum
2  Top margin: 1.97 inches (50 mm) minimum
3 Bottom margin: 0.55 inch (14 mm) minimum
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Roll paper - borderless printing

1 Top margin: 1.97 inches (50 mm) minimum
2 Bottom margin: 0.55 inch (14 mm) minimum

Note: For continuous printing on roll paper, there is no margin between printed images (normal and
borderless printing).
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CD/DVD

1  Minimum inner margin: 0.83 inch (21 mm)
2  Maximum outer margin: 4.72 inch (120 mm)

Parent topic: Technical Specifications

Ink Cartridge Specifications

Note: We recommend that you use genuine Epson cartridges and do not refill them. The use of other
products may affect your print quality and could result in printer damage.

The cartridges included with the printer are designed for printer setup and not for resale. After some ink
is used for priming, the rest is available for printing. Yields vary considerably based on images printed,
print settings, paper type, frequency of use, and temperature. For print quality, a variable amount of ink
remains in the cartridge after the "replace cartridge" indicator comes on.

Color Black cartridge: Photo Black, Matte Black, Light Black, and Light
Light Black inks

Color cartridge: Yellow, Cyan, Light Cyan, Vivid Magenta, and Vivid
Light Magenta inks

200



Cartridge life Opened package: 6 months

Unopened package: do not use if the date on the package has
expired

Temperature Storage: —4 to 104 °F (=20 to 40 °C)
Within a month at 104 °F (40 °C)
Ink freezes at 5 °F (—15 °C); if left for a long time

Ink thaws and is usable after 3 hours at 77 °F (25 °C) with no
condensation

Note: For best printing results, use up a cartridge within 6 months of opening the package.

Parent topic: Technical Specifications

Related references
Ink Cartridge Part Numbers

Dimension Specifications

Height Stored: 9.0 inches (228 mm)
Printing: 16.7 inches (424 mm)
Width Stored: 24.3 inches (616 mm)
Printing: 24.3 inches (616 mm)
Depth Stored: 14.5 inches (369 mm)
Printing: 32.0 inches (814 mm)
Weight 33.11b (15.0 kg)

(without ink cartridges)
Parent topic: Technical Specifications

Electrical Specifications

Power supply rating 100to 120 V
220to 240V
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Input voltage range 100 to 120 V model: 90 to 132 V
220 to 240 V model: 198 to 264 V

Rated frequency range 50/60 Hz
Input frequency range 49.5/60.5 Hz
Rated current 100to 120 V model: 0.6 A
220t0 240 V model: 0.3 A
Power consumption Printing: Approximately 20 W (ISO/IEC24712)
(100 to 120 V model) Ready mode: Approximately 5.3 W

Sleep mode: Approximately 1.4 W

Power off mode: Approximately 0.15 W
Power consumption Printing: Approximately 20 W (ISO/IEC24712)
(200 to 240 V model) Ready mode: Approximately 5.3 W

Sleep mode: Approximately 1.4 W

Power off mode: Approximately 0.3 W

Parent topic: Technical Specifications

Environmental Specifications

Temperature Operating:
50 to 95 °F (10 to 35 °C)
Storage before unpacking:
—4t0 140 °F (—20 to 60 °C)
Within 120 hours at 140 °F (60 °C); within a month at 104 °F (40 °C)
Storage after unpacking:
—4t0 140 °F (—20 to 60 °C)
Within a month at 104 °F (40 °C)
Humidity Operating: 20 to 80% RH
(without condensation) Storage: 5 to 85% RH
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Parent topic: Technical Specifications

Interface Specifications
One High-Speed USB port for connection to computer
Parent topic: Technical Specifications

Network Interface Specifications

Wi-Fi

Standard IEEE 802.11 b/g/n

Security WPA-PSK (TKIP/AES); complies with WPA2
WEP (64/128 bit)

Frequency band 2.4 GHz

Communication mode Infrastructure mode
Ad hoc mode (IEEE 802.11 n not supported in this mode)

Ethernet

Ethernet 100BASE-TX/10 Base T standard
Parent topic: Technical Specifications

Safety and Approvals Specifications

United States Safety: UL60950-1
EMC: FCC part 15 Subpart B class B
Canada Safety: CAN/CSA C22.2 No. 60950-1
E(I\/I)C]: CAN/CSA-CEI/IEC CISPR 22 Class B [CAN ICES-3(B)/NMB-
B

This equipment contains the following wireless module:
* Manufacturer: Askey Computer Corporation.
* Type: WLU6117-D69 (RoHS)
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This product conforms to Part 15 of FCC Rules and RSS-210 of the IC Rules. Epson cannot accept
responsibility for any failure to satisfy the protection requirements resulting from a non-recommended
modification of the product. Operation is subject to the following two conditions: (1) this device may not
cause harmful interference, and (2) this device must accept any interference received, including
interference that may cause undesired operation of the device.

To prevent radio interference to the licensed service, this device is intended to be operated indoors and
away from windows to provide maximum shielding. Equipment (or its transmit antenna) that is installed
outdoors is subject to licensing.

Parent topic: Technical Specifications
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Notices

Check these sections for important notices about your product.

Note: Epson offers a recycling program for end of life products. Please go to this site for information on
how to return your products for proper disposal.

Important Safety Instructions
FCC Compliance Statement
Trademarks

Copyright Notice

Important Safety Instructions
Before using your Epson product, read and follow these safety instructions.

General Printer Safety Instructions

Ink Cartridge Safety Instructions

LCD Screen Safety Instructions
Wireless Connection Safety Instructions

Parent topic: Notices

General Printer Safety Instructions
» Be sure to follow all warnings and instructions marked on the printer.
» Use only the type of power source indicated on the printer's label.

» Use only the power cord that comes with the printer. Use of another cord may cause fires or shock. Do
not use the cord with any other equipment.

» Place the printer near a wall outlet where the plug can be easily unplugged.

» Avoid plugging the printer into an outlet on the same circuit as a photo copier or air control system that
regularly switches on and off, or on an outlet controlled by a wall switch or timer.

» Do not let the power cord become damaged or frayed.

 |If you use an extension cord with the printer, make sure the total ampere rating of the devices plugged
into the extension cord does not exceed the cord's ampere rating. Also, make sure the total ampere
rating of all devices plugged into the wall outlet does not exceed the wall outlet's ampere rating.
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Always turn off the printer using the power button, and wait until the power light stops flashing before
unplugging the printer or cutting off power to the electrical outlet.

Place the printer on a flat, stable surface that extends beyond its base in all directions. It will not
operate properly if it is tilted or at an angle.

Leave enough space in front of the printer for the paper to be fully ejected.
Avoid locations that are subject to rapid changes in heat or humidity, shocks or vibrations, or dust.
Do not place the printer near a radiator or heating vent or in direct sunlight.

Leave enough room around the printer for sufficient ventilation. Do not block or cover openings in the
case or insert objects through the slots.

Keep the printer away from potential sources of electromagnetic interference, such as loudspeakers or
the base units of cordless telephones.

When connecting the printer to a computer or other device with a cable, ensure the correct orientation
of the connectors. Each connector has only one correct orientation. Inserting a connector in the wrong
orientation may damage both devices connected by the cable.

Do not touch the flat white cable inside the printer.

Do not move the print head by hand; this may damage the printer.
Do not spill liquid on the printer.

Do not insert objects into the slots in the printer.

Do not use aerosol products that contain flammable gases inside or around the printer. Doing so may
cause fire.

Except as specifically explained in your documentation, do not attempt to service the printer yourself.

Unplug the printer and refer servicing to qualified service personnel under the following conditions: if
the power cord or plug is damaged; if liquid has entered the product; if the product has been dropped
or the case damaged,; if the product does not operate normally or exhibits a distinct change in
performance. Adjust only those controls that are covered by the operating instructions.

If damage occurs to the plug, replace the cord set or consult a qualified electrician. If there are fuses in
the plug, make sure you replace them with fuses of the correct size and rating.

Leave the ink cartridges installed. Removing the cartridges can dehydrate the print head and may
prevent the printer from printing.

Before transporting the printer, make sure that the print head is in the home (far right) position and the
ink cartridges are in place.
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When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside down;
otherwise ink may leak from the cartridges.

Parent topic: Important Safety Instructions

Ink Cartridge Safety Instructions

Keep ink cartridges out of the reach of children and do not drink the ink.

Be careful when you handle used ink cartridges; there may be ink remaining around the ink supply
port. If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them
immediately with water.

Do not put your hand inside the product or touch any cartridges during printing.

Install a new ink cartridge immediately after removing an expended one. Leaving cartridges
uninstalled can dry out the print head and may prevent the product from printing.

Do not remove or tear the label on the cartridge; this can cause leakage.

Do not remove the transparent seal from the bottom of the cartridge. This may cause the cartridge to
become unusable.

Do not break the hooks on the side of the cartridge when removing it from the packaging.
Do not touch the green IC chip on the side of the cartridge. This may prevent normal operation.
Do not shake cartridges after opening their packages; this can cause them to leak.

If you remove an ink cartridge for later use, protect the ink supply area from dirt and dust and store it in
the same environment as the product. Note that there is a valve in the ink supply port, making covers
or plugs unnecessary, but care is needed to prevent the ink from staining items that the cartridge
touches. Do not touch the ink cartridge ink supply port or surrounding area.

Use an ink cartridge before the date printed on its package.
Do not dismantle an ink cartridge. This could damage the print head.
Store ink cartridges in a cool, dark place.

After bringing an ink cartridge inside from a cold storage site, allow it to warm up at room temperature
for at least three hours before using it.

Store ink cartridges with their labels facing upward. Do not store cartridges upside down.

Parent topic: Important Safety Instructions

LCD Screen Safety Instructions

Use only a dry, soft cloth to clean the LCD screen. Do not use liquid or chemical cleansers.
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 |Ifthe LCD screen is damaged, contact Epson. If the liquid crystal solution gets on your hands, wash
them thoroughly with soap and water. If the liquid crystal solution gets into your eyes, flush them
immediately with water. If discomfort or vision problems remain after a thorough flushing, see a doctor
immediately.

» Do not press too hard on the LCD screen.
» Do not use a pointy or sharp object, such as a pen or your fingernail, to operate the LCD screen.
Parent topic: Important Safety Instructions

Wireless Connection Safety Instructions

Radio waves from this product may adversely affect the operation of medical equipment or automatically
controlled devices, such as pacemakers, automatic doors or fire alarms. When using this product near
such devices or inside a medical facility, follow the directions from authorized staff members at the
facility, and follow all posted warnings and directions on the device to avoid causing an accident.

Parent topic: Important Safety Instructions

FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio or television reception. However, there is no guarantee that interference will not
occur in a particular installation. If this equipment does cause interference to radio and television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following measures:

» Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.
» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will invalidate the FCC
Certification or Declaration of this device and may cause interference levels which exceed the limits
established by the FCC for this equipment. It is the responsibility of the user to obtain and use a shielded
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equipment interface cable with this device. If this equipment has more than one interface connector, do
not leave cables connected to unused interfaces. Changes or modifications not expressly approved by
the manufacturer could void the user’s authority to operate the equipment.

For Canadian Users

CAN ICES-3(B)/NMB-3(B)

Parent topic: Notices

Trademarks

EPSON®, Epson UltraChrome®, Signature Worthy®, Supplies Central®, and SureColor® are registered
trademarks; Epson Connect™ is a trademark; and EPSON Exceed Your Vision is a registered logomark
of Seiko Epson Corporation.

UltraSmooth® is a registered trademark, Designed for Excellence™ is a trademark, and Epson Store®" is
a service mark of Epson America, Inc.

Epson iPrint™ and Remote Print™ are trademarks of Seiko Epson Corporation.

Apple, iPad, iPhone, iPod touch, Mac, and OS X are trademarks of Apple Inc., registered in the U.S. and
other countries. AirPrint and the AirPrint logo are trademarks of Apple Inc.

Google® is a registered trademark and Android™ , Chromebook™ , Gmail™ , Google Chrome™ , Google
Cloud Print™ , Google Drive™ , Picasa™ and YouTube™ are trademarks of Google Inc.

Wi-Fi Direct® is a registered trademark of Wi-Fi Alliance®.

General Notice: Other product names used herein are for identification purposes only and may be
trademarks of their respective owners. Epson disclaims any and all rights in those marks.

EPSON

EXCEED YOUR VISION

Parent topic: Notices

Copyright Notice

All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or
transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or otherwise,
without the prior written permission of Seiko Epson Corporation. The information contained herein is
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designed only for use with this Epson product. Epson is not responsible for any use of this information as
applied to other products.

Neither Seiko Epson Corporation nor its affiliates shall be liable to the purchaser of this product or third
parties for damages, losses, costs, or expenses incurred by purchaser or third parties as a result of:
accident, misuse, or abuse of this product or unauthorized modifications, repairs, or alterations to this
product, or (excluding the U.S.) failure to strictly comply with Seiko Epson Corporation's operating and
maintenance instructions.

Seiko Epson Corporation shall not be liable for any damages or problems arising from the use of any
options or any consumable products other than those designated as Original Epson Products or Epson
Approved Products by Seiko Epson Corporation.

Seiko Epson Corporation shall not be held liable for any damage resulting from electromagnetic
interference that occurs from the use of any interface cables other than those designated as Epson
approved Products by Seiko Epson Corporation.

This information is subject to change without notice.

A Note Concerning Responsible Use of Copyrighted Materials
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Parent topic: Notices

A Note Concerning Responsible Use of Copyrighted Materials

Epson encourages each user to be responsible and respectful of the copyright laws when using any
Epson product. While some countries' laws permit limited copying or reuse of copyrighted material in
certain circumstances, those circumstances may not be as broad as some people assume. Contact your
legal advisor for any questions regarding copyright law.

Parent topic: Copyright Notice

Default Delay Times for Power Management for Epson Products

This product will enter sleep mode after a period of nonuse. This is to ensure that the product meets
Energy Star standards of energy efficiency. More energy savings can be achieved by setting the time to
sleep to a shorter interval.
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